The Brooklyn Museum: An Internship in Copyright Clearance

Alice Cork
University of New Orleans

Follow this and additional works at: https://scholarworks.uno.edu/aa_rpts

Recommended Citation
Cork, Alice, "The Brooklyn Museum: An Internship in Copyright Clearance" (2011). Arts Administration Master's Reports. 120.
https://scholarworks.uno.edu/aa_rpts/120

This Master's Report is protected by copyright and/or related rights. It has been brought to you by ScholarWorks@UNO with permission from the rights-holder(s). You are free to use this Master's Report in any way that is permitted by the copyright and related rights legislation that applies to your use. For other uses you need to obtain permission from the rights-holder(s) directly, unless additional rights are indicated by a Creative Commons license in the record and/or on the work itself.

This Master's Report has been accepted for inclusion in Arts Administration Master's Reports by an authorized administrator of ScholarWorks@UNO. For more information, please contact scholarworks@uno.edu.
The Brooklyn Museum:
An Internship in Copyright Clearance

A Masters Report

Submitted to the Graduate Faculty of the
University of New Orleans
in partial fulfillment
of the requirements for the degree of

Master of Arts
in
Arts Administration

By
Alice Cork
B.A. Loyola University New Orleans, 2006
May, 2011
# Table of Contents

Abstract .............................................................................................................................. iv
Chapter 1: Profile of the Brooklyn Museum........................................................................1
  Collections .....................................................................................................................1
  Mission .........................................................................................................................2
  Organizational Structure ............................................................................................3
  Budget ..........................................................................................................................4
  Programs .......................................................................................................................6
Chapter 2: Description of Internship....................................................................................9
  Responsibilities ..........................................................................................................9
  Desired Outcomes: Intern ........................................................................................10
  Desired Outcomes: Brooklyn Museum ..........................................................................11
Chapter 3: Digitization Efforts in the Context of Museum History...................................16
Chapter 4: Digital Lab Projects..........................................................................................20
Chapter 5: The Creation of Community ...........................................................................26
Chapter 6: Rights and Reproduction Projects ....................................................................27
Chapter 7: Attracting a Diverse Audience .......................................................................31
Chapter 8: SWOT Analysis with Reference to Best Practices ..........................................35
Chapter 9: Conclusion........................................................................................................41
  Contributions and Outcomes of the Internship ........................................................41
  Recommendations ....................................................................................................41
Bibliography ......................................................................................................................47
Appendices .......................................................................................................................51-137
  A: Brooklyn Museum Organizational Chart .............................................................. 51
  B: Brooklyn Museum Rental Agreement and Facilities Description .........................52
  C: Brooklyn Museum 2008 Income Statement ............................................................54
  D: Brooklyn Museum Copyright Clearance Process Overview ....................................55
  E: Sample Letter to Estate ..........................................................................................57
  F: Sample Letter to Artist ..........................................................................................58
  G: Non-Exclusive License ...........................................................................................59
  H: Brooklyn Museum Copyright Clearance Manual .....................................................61
  I: Creative Commons License ......................................................................................121
  J: Brooklyn Museum Rights and Reproductions Fee List ............................................127
  K: Application to Reproduce Works ...........................................................................129
  L: Brooklyn Museum Reproduction Agreement .........................................................131
  M: Sample Rights and Reproductions Invoice ............................................................133
  N: Internship Evaluation ............................................................................................135
Vita .....................................................................................................................................138
Abstract

This report was written as the result of a 480 hour internship from September to December of 2010 with the Brooklyn Museum as the culmination of the Masters of Arts Administration program at the University of New Orleans. At the Brooklyn Museum, I served as a fulltime copyright clearance intern. This report aims to describe the goals of the Copyright Clearance Project as they serve the greater vision of the Museum, and how these efforts fit within an historical context and compare to contemporary best practices in the Arts Administration field.
Chapter 1: Profile of the Brooklyn Museum

History

The Brooklyn Museum, presently located at 200 Eastern Parkway, Brooklyn, NY has origins that date to 1823 when the Brooklyn Apprentices’ Library was founded in Brooklyn Heights. In 1843 the Library and the Brooklyn Lyceum combined to form the Brooklyn Institute, a center for arts and education. By 1846 the Institute planned to house a permanent collection of fine art, and by 1893 the Institute was re-envisioned as the Brooklyn Institute of Arts and Sciences, a complex so grand that it encompassed what would later become the Brooklyn Academy of Music, the Brooklyn Botanic Garden, and the Brooklyn Children’s Museum. The museum division was intended to serve as the center of culture, recreation, and education for what was then the independent city of Brooklyn.

Construction on the west wing of the new museum building began in 1895 and opened to the public only two years later. The second phase of construction began in 1899 with the central pavilion and the grand Eastern Parkway entrance. This stairway, which was completed by 1905 and fated to be remodeled in several controversial ways over the years, was originally twice the height of the famous steps of the Metropolitan Museum of Art. In 1926, construction was completed on what would be the third and final stage of major building, the addition of the northeast gallery wing and the Beaux Arts Court. After thirty years of construction, the massive 60,000 square foot Brooklyn Museum is only one fourth of the size of the original architectural design.¹

Collection

Despite aspirations to house the world’s largest collection, The Brooklyn Museum began with only twelve paintings in its possession. The Brooklyn Museum now boasts a collection of almost a million highly diverse objects, which in the physical galleries, are classified into thirteen major taxonomies: African, American, Islamic, Asian, Decorative, Egyptian, Classical, European, Pacific Island, Photographic, Feminist and Contemporary, and near limitless categories online as visitors to the website are invited to tag objects with any descriptor they deem appropriate. Development of the online collections has been an ongoing project since July of 2007 when growing digitization efforts necessitated a search for an adequate Digital Asset Management System (DAMS). With the launch of the Collection on the Web the following year, 5,168 objects and over 10,000 exhibition views were made available online. The number of digitized objects on the web grew to approximately 100,000 by March 2010, and the Digital Collections department is continually endeavoring to increase this number through new photography and an ongoing Copyright Clearance Project. To date, there are roughly 19,000 works in need of non-exclusive licenses to join the online collection.

Mission

The mission of The Brooklyn Museum is to act as a bridge between the rich artistic heritage of world cultures, as embodied in its collections, and the unique experience of each visitor. Dedicated to the primacy of the visitor experience, committed to excellence in every aspect of its collections and programs, and drawing on both new and traditional tools of
communication, interpretation, and presentation, the Museum aims to serve its diverse public as a dynamic, innovative, and welcoming center for learning through the visual arts.²

**Organizational Structure**

The Brooklyn Museum has a 26 person Board of Trustees headed by Norman M. Feinberg, Chair; Barbara Knowles Debs, Vice Chair; Stephanie Ingrassia, Vice Chair; Constance L. Christensen, Secretary; John S. Tamagni, Treasurer; and Judith Frankfurt, Assistant Treasurer. The executive committee is comprised of Richard M. Cashin, Saundra Cornwell, Joseph G. Finnerty III, Richard W. Moore, Elizabeth A. Sackler, and Richard J. Schwartz. Preeminent members of New York society including the Mayor of New York City, Michael R. Bloomberg; Speaker of the New York City Council, Christine Quinn; Comptroller of New York City, John Liu; Borough President of Brooklyn, Marty Markowitz; Commissioner of Cultural Affairs, Kate D. Levin; and President of Brooklyn Museum Community Committee, Judith Stewart, also provide guidance as Ex-Officio Trustees.

Dr. Arnold L. Lehman has been the Museum’s Director since 1997. Prior to acting as The Brooklyn Museum’s Director, he was Director of the Baltimore Museum of Art for almost twenty years, from 1979 to 1997. He earned both his B.A and M.A. degrees from Johns Hopkins University before going on to specialize in art history at Yale. He is a past president of the Association of Art Museum Directors, and chaired the Federal government’s Art Indemnity Panel.

Reporting directly to the Director are three Deputy Directors, each of whom oversees the functioning of one of the Museum’s three branches: Art, Administration, and Institutional Advancement. Within the scope of Art are the Digital Collections, Library and Archives.

---

Education & Program Development, Collections and Conservation, The Elizabeth A. Sackler Center for Feminist Art, Contemporary Art, Exhibitions, and the Chief Curator whose responsibility is divided between American and European Art, and Art of Ancient Egypt, Africa, and Asia. Finance and Administration, Design, Chief of Technology and Web, Merchandising, Operations, Planning and Architecture, and Head of Publications & Editorial Services fall under the supervision of the Deputy Director of Administration. Marketing & Visitor Services, Public Information Officer, Development, Government Relations Officer, Manager of Community Involvement are directly accountable to the Deputy Director of Institutional Advancement.

The Brooklyn Museum is powered by the combined efforts of 340 full time employees and 175 part time employees. As with most non-profit arts organizations, the Brooklyn Museum also relies heavily on unpaid work. There are an estimated 327 volunteers and interns working in various departments of the Museum.³

Budget

With annual expenses equaling $31.5 million, the Brooklyn Museum falls into the less than 10% of American museums that surpass a budget of $15 million.⁴ Revenue is reported from ten distinct streams: Membership Dues, Fundraising Events, Governmental Grants, Other Contributions, Exhibit Fees, Admission Fees, Educational Programs and Space Use, Parking Lot Fees, Investment Income, Sale of Assets, Sale of Inventory, and Miscellaneous. In opposition to more general trends, the single largest portion of funding comes from governmental grants rather than individual giving.⁵ Despite the positive response from the current administration, the Brooklyn Museum has experienced the capriciousness of governmental funding first hand. In

³ See Appendix A for Organizational Chart

After investment income, admissions revenue for permanent collections, special exhibitions, and educational programs constitutes the next greatest financial contribution to the Museum at $2,237,697. This figure is not surprising as the Museum annually hosts over 300,000 visitors.\textsuperscript{7} The suggested donation for the Brooklyn Museum is ten dollars for adults, six dollars for seniors and students, and free admittance for children under twelve years of age. Memberships range from $20 for the lowest “1\textsuperscript{st} fan” level to the $5,000 “Benefactor” level. Businesses can show their support in the form of a corporate membership, which range from $1,500 to $25,000 and above. The Brooklyn Museum also offers professional development in the form of a Summer Teacher Institute Course for Kindergarten to Eighth Grade Educators for Professional Development Credit that can be used toward Masters Programs. This course has a fee of $625.

In addition to educational programs, the Brooklyn Museum organizes a series of special events and fundraisers throughout the year. These events range from relatively small gatherings

\textsuperscript{7} IRS 990 form
such as the Mother’s Day Brunch, which provides brunch and a guided tour of one of the exhibitions for $50, or Fermented Harmony Wine and Cheese 101, which offers an expert wine and cheese pairing lesson for $65, to extravagant balls. The Brooklyn Artists Ball, for instance, promises cocktails, dinner, dancing, and celebrities for those able to purchase tickets that range from $500-50,000.

The Brooklyn Museum also utilizes its space to generate needed rental income. Seven areas of the Museum, The Martha A. and Robert S. Pavilion and Lobby, the Glass Corridor, Museum Café, The Beaux-Arts Court, The Iris and B. Gerald Cantor Auditorium, The Iris and B. Gerald Cantor Gallery, and The Steinberg Family Sculpture Garden are available to members at the $250/350 level for rent for a $5,000 space fee in addition to a $5,000 staffing fee. The Museum also benefits from public parking lot fees that account for $84,838 income annually. The Museum very recently made the unpopular decision to charge employees for parking space.

As may be expected the greatest expense of the museum is the compensation paid to employees and the associated payroll taxes. Other major expenses include fees paid to non-employee professionals for services rendered, advertising and promotion, office expenses, depreciation, insurance, travel allowances, and miscellaneous expenses.

In 2008, the Brooklyn Museum reconciled its budget with a net income of $9,960,790.9

Programs

To supplement its collections and special exhibitions, the Brooklyn Museum offers a wide range of educational programs. Each day free guided tours are offered for members and the general public. Panel Discussions, as well as a specialized series of Feminist Art Panel Discussions, in which reputable artists, art commentators, and writers are invited to investigate

---

8 See Appendix B for Rental Agreement and Facility Descriptions
9 See Appendix C for Income Statement
pertinent issues are held regularly. Youth, Teen, and Family centered programming have been developed to make the Museum an engaging environment for all ages. Specifically, there is Meet the Museum for infants, Arty Facts for toddlers and young children, art classes in the Gallery/Studio and day camps for older children. Teens have an active role in the planning of Free Teen Night. Adult programs address a spectrum of artistic expression. Film nights, Family Performances, as well as the Music Off the Wall series, and creative art making opportunities illustrate the Brooklyn Museum’s commitment to offering an integrative art experience.

Evening Programs include end of the week extended hours, Thursdays@7 and Target First Saturdays. Thursdays@7 programming tends to lean toward exhibition guides and lectures while Target First Saturday is a monthly late night of art and entertainment followed by a dance party. First Saturday was first introduced as a means of making the Museum more attractive to a younger audience. A wildly popular event, the first First Saturday saw 2,500 visitors, and it now averages 10-12,000 each month. August of 2011 set a record of 24,000 attendees.

In addition to programming within its physical walls, the Brooklyn Museum is largely defined by its online network referred to as the Community. The Brooklyn Museum Posse is made of audience members who have established user profiles in the Community. Posse participants are able to engage with the Museum in various ways meant to supplement physical visits. As well as receiving regular information updates, they may create their own online galleries by reorganizing pieces from the collection, and take part in interactive games such as Tag, in which users create networks of objects by adding original metadata, or alternatively, Freeze Tag, which allows users to vote to stop tags that they feel are inappropriate. Comment pages are enabled for each exhibition to encourage immediate feedback for the shows as a whole as well as for individual works. The Museum Community is also welcome to take pictures in
most of the galleries as well as make original audio or visual recordings to upload to numerous user generated content sites such as Flickr, Facebook, Twitter, Tumblr, Youtube, iTunes, Yelp, and Foursquare.
Chapter 2: Description of Internship

Responsibilities

Copyright Clearance

The primary position of the internship was as a Copyright Clearance Intern. Responsibilities included defining a population of protected objects, researching the copyright holder(s), locating contact information, and generating appropriate non-exclusive licenses for the pieces in the Brooklyn Museum collection.10

Rights and Reproduction

I also assisted Rights and Reproductions by processing incoming requests and invoices for image reproduction for for-profit book publishing, personal, not-for-profit, and educational usages.

Intern Training

I assisted with the training of a fellow part-time intern in research methods as well as the use of The Museum System (TMS), Access, and the reports necessary to generate the Brooklyn Museum’s licenses.

Museum Visits

Weekly, I made a site visit to one of the other museums of New York City to familiarize myself with the collections and programming at other institutions.

Status Meetings

I met with the Head of Digital Collections and Services biweekly to discuss the progress made in clearing the copyright for objects included in a current IMLS grant and review any unusual cases.

---

10 See Appendix D for Copyright Clearance Project Overview
**Desired Outcomes: Intern**

As a student of the Arts Administration program at the University of New Orleans it has been my goal to receive a comprehensive education of the challenges facing arts organizations in today’s business climate and strategies for successful Marketing, Development, Legal, and Business operations. For me, the most compelling issues covered in the program were ways of creating a cohesive brand identity, developing innovative programming to engage the community, the inherent value of art objects and the ways that changing laws dictate and respond to the zeitgeist of the art world, and the evolution of the construct of the museum in a historical context. Throughout the program, I gained practical experience in various New Orleans based organizations, and I hoped to venture outside of the immediate arts community for my final internship.

The Brooklyn Museum’s dedication to transparency of information, image availability, and to the creation of an extensive online community made it a particularly appealing destination for my requisite final internship. Through previous research I had been made aware of the pioneering efforts of the Brooklyn Museum, especially within Digital Collections and Services, or Digital Lab as it is more informally known, and the Technology Department. I found that the Brooklyn Museum was making strides to resolve the problem of balancing the unparalleled opportunity the internet offers to enrich people’s lives with art and a respect for artists’ rights to protect their work from illegal distribution. Prompted by a particular interest in copyright, I happily accepted a position as Copyright Clearance Intern. The position at the Brooklyn Museum was seen as an invaluable opportunity to explore these issues as they apply in reality and culminate my formal education in a world class museum.
Desired Outcomes: Brooklyn Museum

Within the broader Mission of the Brooklyn Museum, the Digital Lab retains its own Mission: “Create, manage, make accessible, and preserve digital images documenting the Museum Collections, research resources, and activities.”\textsuperscript{11} Furthermore, the aim of the ongoing Copyright Clearance Project is clearly defined, “Make as much of the collection available as possible, with as few restrictions as possible, as openly as possible, while respecting the rights of the artists.”\textsuperscript{12} The Copyright Clearance Project has arisen out of the Brooklyn Museum's efforts to create an online community and meaningfully contribute to the Web 2.0.

When one considers the hours required to digitize a tremendous collection, the patience required to sleuth out the correct copyright holders, and then the organization necessary to provide this information while simultaneously adjusting to the suggestions and demands of a vocal public, it seems ludicrous that any organization would willingly join the world of Web 2.0. It would be indisputably easier for arts administrators to continue to keep a tight grasp on images; however, social networking sites are becoming ever stronger and more popular resources for the public, and the arts have been forced to adapt to stay relevant.

The term Web 2.0 has become popular in common lexicon to describe an online environment that features two way communications rather than a one way stream. In traditional marketing, a message is encoded and sent through a channel by a sender to a receiver on the other end, who is hopefully able to process the message in spite of external noise and successfully decode its intention.\textsuperscript{13} Web 2.0 changes this paradigm in several ways.\textsuperscript{14} By

\begin{footnotesize}
\begin{itemize}
\item \textsuperscript{11} Wythe, Deborah. “Rights Transparency: The Brooklyn Museum Copyright Project.” \textit{Museums and Computer Network: Austin 2010}.
\item \textsuperscript{12} Wythe, D. “Rights Transparency”
\item \textsuperscript{13} Clow, K., Baack, D. \textit{Integrated Advertising, Promotion, and Marketing Communications}, 4th ed (2010)
\end{itemize}
\end{footnotesize}
O’Reilly’s estimation, pertinent aspects of Web 2.0 include application areas that provide an arena for contribution, for instance, blogs, wikis, social sharing, and social networking sites. Websites that feature easily embedded or reused content and the culture of open sharing are also indicative of the transition to Web 2.0. Networks in this model become a platform for externally hosted services instead of being managed exclusively by an organization. The environment created by this 2.0 version of the internet is one in which individuals have shifted from a passive role as receptors to one where they actively shape and transmit information.

While the evolution of knowledge is not new, experts and exceptionally engaged members of the general public have been taking part in this dialogue for millennia, sites such as Wikipedia and Facebook have normalized and expedited this behavior for the masses. Art organizations such as the Brooklyn Museum have recognized the value of adopting such social programming to not only boost the bottom line of membership and ticket sales, but to truly fulfill their missions.

A museum may be defined as “a non-profitmaking, permanent institution in the service of society and of its development, and open to the public, which acquires, conserves, researches, communicates and exhibits, for purposes of study, education and enjoyment, material evidence of people and their environment.”15 A present day institution could not accurately depict life in the twenty-first century without acknowledging our virtual environment. By instituting social networking, or “I” sites, as well as social media, or “Us” sites, museums can both market more acutely and successfully to specific lifestyles as well as educate more wholly.16 “I” sites are those such as Facebook, Myspace, and Twitter that present an individual’s or organizations’

personal information, likes, dislikes, thoughts, and activities to a network of other individuals. “Us” sites are those like Flickr, Wikimedia Commons, or the Brooklyn Museum’s online Gallery Tag feature, which act to organize individuals around a common interest in content. Sharing collections on both platforms enables museums to satisfy their responsibility of acting as entrusted guardians of cultural legacies and also expands their role to directly inspiring contributions and creative activity from audiences. Through social media and social networking, the public become writers, curators, and artists in their own right.

Legal considerations make this idealistic goal considerably more complex because the process to “align digital culture and copyright” has been a very litigious one. Copyright law is a lugubrious labyrinthine beast that has yet to be tamed in the new realms that the web has created. Because the internet is fundamentally ruled by interaction, the transmission of information among various levels, it is not a surprise that when material has unlawfully passed through the chain, suits have been brought against every point of transmission. Individual users, websites and applications, and internet service providers (ISPs) have all been the object of litigation. Users of Napster will readily remember the ‘cease and desist’ letters sent for downloading copyrighted materials. In 2008, the ISP iiNet faced charges that it had infringed copyright law by not preventing its users from pirating audiovisual content. Thirty-four plaintiffs including Village Roadshow, Universal Pictures, Warner Brothers, Paramount Pictures,

19 Wiseman, A. 2008
and Sony Pictures charged that iiNet “authorized infringement” and was therefore responsible for damages. The courts ultimately decided in favor of iiNet.\textsuperscript{20}

Most notable for arts organizations looking to develop their web presence may be a case brought against Google, Inc. when it was sued in 2006 by the corporation Perfect 10.\textsuperscript{21} Perfect 10 brought this action against Google for hosting thumbnails of, and linking to, copyrighted material. In this case the linked material was inconsequential because Google did not physically house the images on its own servers, but rather connected to the HTML of other sites, so it was not technically distributing or displaying the work. Issues surrounding the thumbnails, however, were not as easily dismissed because Google does in fact store these cached images on its servers. Google contended, and it was upheld by the court, that the use of the thumbnails was protected by fair use.

Fair use as a defense is described in 17 U.S.C. § 107 and permits the use of copyrighted material in instances that reify the creative process. To determine fair use one must consider the purpose and character of the use, including whether such use is of a commercial purpose or is for nonprofit educational purposes, the nature of the copyrighted work, the amount and substantiality of the portion used in relation to the copyrighted work as a whole, and the effect of the use upon the potential market value of the copyrighted work.\textsuperscript{22} Google benefited from the precedent of Kelly V. Arriba Soft Corp. which, in a similar case, found that Arriba’s use of thumbnails was a fair use because as a search engine it had a significant “transformative nature” and provided a “benefit to society.”\textsuperscript{23}

\begin{flushright}
\textsuperscript{21}Perfect 10, Inc. V. Google, Inc., 2007. 487 F.3d 701. case found on the Westlaw electronic database. 2010
\textsuperscript{22}17 U.S.C. § 107.
\textsuperscript{23}Kelly V. Arriba Soft Corp. 336 F. 3d 811 case found on the Westlaw electronic database. 2010
\end{flushright}
Museums have a similar if not even greater claim to the posting of their images under the tenants of fair use in that they are nonprofit organizations that must be “essentially educational in nature.”

These institutions, however, are finding themselves in the midst of a convoluted process because while a precedent has been set and online thumbnails are considered acceptable and not an infringement of copyright, making high resolution images more accessible may be. As institutions attempt to remain competitive and relevant in social networking and media by posting their collections more completely and making these full-size images available through online streams, they are finding it necessary to seek out copyright holders.

Of the countless arts organizations that have begun digitizing collections, communicating heavily through social networking, and subsequently undertaking the daunting task of locating authors and securing appropriate licenses, the Brooklyn Museum has become an outspoken advocate for the process and the need for accuracy and transparency by attending and presenting at the numerous conferences that address digital rights issues, WebWise, Museums and the Web, Museum and Computer Network, Legal Issues in Museum Administration. As a member of Digital Collections and Services, it was expected that I would research and contact as many artists as possible to facilitate the expansion of the Collections of the Web, as well as provide information about the project and its goals to constituents.

---

25 Wythe, Deborah. Personal Interview. (September 29, 2010)
Chapter 3: Digitization Efforts in the Context of Museum History

Rembrandt Peale converted what had been his father’s own cabinet of curiosities into the first building dedicated to the sole purpose of being a museum and art gallery in the western hemisphere. The three-story Baltimore Museum and Gallery of Fine Arts was erected in August of 1814, and while the building would go on to have an extensive career in civic use, serving later as the site of City Hall, a minority public school, and the home of the Baltimore Water Board, the original museum remained open for only 15 years. Peale’s museum closely adhered to the lay-out that would later be set forth by John Ruskin as the appropriate organization for all art museums with the first floor being dedicated to natural history and sculpture, the second housing a large library, and the third showcasing paintings. It is perhaps not surprising that in the socio-political and economic climate of the United States, one that prized democracy and revered the average man, the museum would fail. While the European public museum was able to grow leisurely out of an aristocratic unease with commerce, in the U.S. a competitive capitalist market required that the worth of museums be validated by both elite and popular cultures. Potential audiences were drawn to more intriguing forms of entertainment, namely, traveling fairs and hoax shows, and while Peale found he was losing money on his venture, P.T. Barnum, the great impresario, was attracting approximately 400,000 visitors a year and eventually bought portions of the Peale collection.

Instead of trying to remain detached from the sense of wonderment of such shows, museums came to see the need to employ the spectacular in order to further their educational missions and amidst the cultural revolution of the 1960s, Thomas Hoving of the Metropolitan Museum of Art revolutionized the way that the museum approached the public. Having recognized the diminishing appeal of an elitist art world, Hoving proposed making the museum humanistic. He renovated the austere façade of the museum and envisioned a social promenade as well as welcoming steps. He promoted shows with the novel use of large colorful banners, which would later become standard practice for museum exhibitions, and also utilized every technology available to make the museum experience satisfying and educational for all visitors. One of the most impactful contributions of Hoving’s career was the inception of the blockbuster exhibition. “Treasures of Tutankhamun,” the Met’s monumental exhibition of 1978, required a three million dollar guarantee to the president of the Egyptian Organization of Antiquities and resulted in more than 1.2 million visitors. Hoving made museums of the people in that they displayed an interest in their lives, habits and customs in a way that was never acknowledged in the 19th century.

Museums have continued to embrace this appeal to belong to popular culture rather than standing removed from it. A representative from the Solomon R. Guggenheim Museum created a media stir when he asserted that he was in the entertainment business and vying with other forms of entertainment for patrons. Market research has shown that museums have improved the response to blockbuster shows by using celebrities to voice the audio-guides. In many cases

artists and their work are becoming socially celebrated in ways comparable to movie stars, for instance sensational artist Damien Hirst has generated heated debates and high prices for pieces such as *The Physical Impossibility of Death in the Mind of Someone Living*, a shark preserved in formaldehyde, and *For the Love of God*, a diamond encrusted skull. Notorious street artist Banksy has built a reputation on innovative publicity stunts. Most notably, in 2005 he infiltrated such prestigious institutions as the Louvre and Tate Britain with his own work during gallery hours. He said that he had “wandered round a lot of art galleries thinking, 'I could have done that', so it seemed only right [to] try.” This breakdown of the barrier the museum creates between the object and audience through the curation process was very foretelling of coming trends in museum structure.

Advances in technology, specifically the proliferation of Web 2.0 and digitization capabilities, have dramatically impacted the construct of the museum, particularly, the way in which audiences interact with the objects of a collection. In 1999, the Board of Trustees of the Brooklyn Museum signed in a new, audience centered Mission Statement,

> The mission of The Brooklyn Museum is to act as a bridge between the rich artistic heritage of world cultures, as embodied in its collections, and the unique experience of each visitor. Dedicated to the primacy of the visitor experience, committed to excellence in every aspect of its collections and programs, and drawing on both new and traditional tools of communication, interpretation, and presentation, the Museum aims to serve its diverse public as a dynamic, innovative, and welcoming center for learning through the visual arts.

and almost immediately the Information Systems Manager and Chief of Technology began investigating ways in which the new directive could be applied to the Museum’s web presence. By 2006, initial efforts to establish an online community had begun. Uploading videos to Blip.tv

---

36 Lehman, Arnold. *Mission Statement*.
and linking to them back to the Museum’s homepage made for an easy foray into the world of interactive online communities. A simple Flickr account allowed the Museum to track an interactive installation online, as well as enable the first of the Museum’s collections of viewer generated content. Projects grew to include cellular audio tours, podcasts, drawing applications on the website, and online discussion boards all of which allowed the Museum’s audience to respond directly to, and engage with, the collection in ways they had never experienced before.

The digitization of museum collections has resulted in a global catalogue of objects complete with interactive information that, because it is accessible from anywhere with internet connectivity and does not require prior knowledge of the objects, diminishes some of the social division created by the physical museum. In its quest to be a dynamic, innovative, and welcoming center for learning through the visual arts, the Brooklyn Museum, has delved wholeheartedly into the digitization process.

---

39 Lehman, A. Brooklyn Museum Mission Statement. Accessed online 2010
http://www.brooklynmuseum.org/about/mission.php
Chapter 4: Digital Lab Projects

Shortly after the Brooklyn Museum began digitizing its collection, it began researching Digital Asset Management Systems (DAMS). Of the litany of required capabilities, it was imperative to find a program that allowed for strong descriptive and technical metadata. An emphasis was placed on searchability because the ultimate goal of the project was to make the images available online. When the Brooklyn Museum began expanding its collection on the web two years later, the initiative aimed to add more than 4,000 objects from the museum’s library and archives to the more than 15,700 digitized images of artwork and installation views that were already available online. It was deemed important to post the entirety of the museum’s holdings, not just images of the works themselves, but also the artifacts that accompany accessioned objects: letters, photographs, and receipts that create provenance and history for a piece. These documents inform the public of how an object has been interpreted and included in exhibitions, and by providing this background, relinquishing an element of ownership, the museum allows the audience to more fully understand an object even if the viewer has no prior knowledge it. When the viewer appreciates an object’s contextual past and can manipulate its future use, he or she becomes an active participant in the museum experience rather than a passive observer.

It is in this vein of full disclosure that the Brooklyn Museum has endeavored to obtain a non-exclusive license for every work in the collection that is known to be or potentially protected by copyright. “Any analysis of ownership and duration must be performed on a case by case basis.” Despite the singular consideration due to each work in the collection, the Digital

---

41 See Appendices E-G for Sample Cover Letters, Non-Exclusive License, and Orphaned Work Checklist
42 Peter Hirtle, Emily Hudson and Andrew T. Kenyon, Ithaca, NY: Cornell University Library, 2009
Lab began Copyright Clearance Project by creating meaningful subdivisions to make the process more manageable. First, distinct Object Rights Types (ORTs) such as “no known copyright,” “under copyright 1923-1977,” and “under copyright 1978-present” were created to assign to each work. The next step was dividing the collection into distinctive categories to simplify the process of determining copyright status. The two largest discriminatory questions asked about works were, was the piece created pre or post 1923, and is it 2D or 3D. Works created before 1923 are all in the public domain due to copyright expiration, and the Museum owns the copyrights to its images of 3D works. These distinctions left the Brooklyn Museum with 19,000 copyrighted works and 4,300 artists from whom to secure licenses. The process of locating these artists has been successful if not a little slow moving. By the winter of 2010, 5,571 works by 372 artists had been cleared. Finding copyright holders is very much a detective game that often begins with a Google search and ends with the triangulation of information from various sources. To facilitate the process, the Digital Lab has produced a thoroughly detailed Copyright Clearance Manual, which is freely available to other institutions tackling a similar undertaking.

The hours of work that have gone into the Copyright Clearance Project have facilitated a very respectable goal of making the collections available online and therefore to the widest possible audience in a very respectful manner. As well as increasing the accessibility of the collection, this project is opening the collection to a range of community building activities, and contributing to the revenue of the museum through increased exposure. In order to advance the mission even further; however, I feel it is necessary to also make the copyright holder information accessible to the public. The Brooklyn Museum has been more than willing to share

---

45 Yu, A., 2010
46 See Appendix H for Copyright Manual
information with other institutions steeped in a similar copyright clearance process in many ways, such as offering copies of the nonexclusive license, presenting research methods, and a detailed usable system, as well as directly sharing copyright holder contact information with interested parties. This exchange, while certainly helpful, has been happening on an extremely limited one to one basis usually when another institution inquires about a particular artist or in a small group setting on discussion boards such as MusIP.

By far, the most cumbersome portion of the project is the overwhelming number of work hours required to track down correct copyright holders, and it is even more challenging to find valid contact information for them. Eventually compiling this data into a searchable platform, that is open to the public online or formatted as an application for mobile devices, would save countless hours of redundant research. The database would be helpful to those in search of public domain works for personal projects, and has the potential to encourage other museums to follow suit and undertake the process of clearing their own collections and making them available online.

The Writers, Artists, and Their Copyright Holders (WATCH) database of the Harry Ransom Center at the University of Texas at Austin and the University of Reading Library provides a useful model for this prospective project. The WATCH database was established in 1994 to provide users with information about copyright holders and ways to contact them. It has since grown into one of the largest databases of copyright holders in the world, with 17,550 records as of March 2011, and is an invaluable resource for literary researchers. If the Brooklyn Museum were to create a similar interface for visual artists it would offer the same benefit for those researching the creators of paintings, prints, illustrations, and sculptures.

47 Workman, Richard Personal Interview. (April 4, 2011)
48 WATCH File. “About WATCH.” Accessed online: http://tyler.hrc.utexas.edu/about.cfm
It is not always as simple as merely finding the author, though; some are hesitant to give the necessary rights. Because the collection is on the web, it is imperative to specify that images may be used worldwide. As with many licensees the Museum has also tried to future-proof the license by noting that the release shall apply to any and all media that are currently or may in the future be used. It is these broad stipulations that have raised concerns for copyright holders despite the fact that the license the Brooklyn Museum is attempting to secure is non-exclusive. When there is resistance from a copyright holder, the Museum first tries to assuage any worries by making the license fully amendable, and if concerns persist, they request permission solely for inclusion in the online collections.

Another consideration for rights-holders is that museums, like the Brooklyn Museum, do not proactively monitor for illegal use of images after they have been posted to the website. During the internship, one image was discovered to have been used in a way that infringed upon the copyright of the Brooklyn Museum. An individual, Maurice4, was using an image from the online collections to accompany an eBay listing. The individual was approached and promptly removed the image; however, had the Museum not been alerted by a third party of the use, it would have gone unnoticed, and such insecurity may prohibit some rights-holders from agreeing to be included in the Collections on the Web.

In order to successfully compete with For-Profit Licensing Agencies, the Museum will have to be more proactive. One benefit of For-Profit Licensing Agencies, such as the Artist Rights Society (ARS) and the Visual Arts and Galleries Association (VAGA), is that they offer protection of an artist’s images, and they offer international coverage through a network of sister societies. ARS additionally provides legal and financial support with issues that arise from
reproduction permissions. Due to the Museum’s commitment to balancing image availability with artist rights, it is necessary for the Museum to proactively invest in ensuring that images are not illegally reproduced. They can do so through such means as implementing image tracking software. Services such as PicScout use fingerprinting technology to compare images in their database to those posted on the web. The system scans 600 million images a month and over 6 billion a year. When a match is found, a report that includes a screenshot, the URL, and the type of use is generated for the account holder. This particular service charges a service fee, but because of available online software, price need not be a prohibitive issue for museums. A comparison in *Plagiarism Today* enumerates the benefits of eleven free online image tracking tools that artists can use to protect their work.

In another attempt to promote the freedom of information, the Museum has shifted from using a CC-BY-NC-ND to the less restrictive CC-BY-NC as its default license on the images for which it owns the copyrights. Creative Commons is a nonprofit that offers free licensing and other easy to use legal tools to stimulate the creative economy. The licenses they offer range from the fairly permissive attribution license, which requires only that the original creation be credited, to the relatively restrictive attribution non-commercial no derivatives license, which prohibits changing a piece or using it commercially. It does allow for the image to be distributed as long as it is properly attributed. The Brooklyn Museum’s switch means that others may now

---

49 ARS. “About Artist’s Rights Society.” Accessed online: http://www.arsny.com/about.html
53 Creative Commons. *What is CC*. Accessed online 2010 http://creativecommons.org/about/what-is-cc
make derivative works but they must be non-commercial and be attributed to the original artwork.\textsuperscript{54}

Deborah Wythe, Head of Digital Collections and Services, says, “The Brooklyn Museum has pursued getting our images and data out to people, rather than expecting them to come here.”\textsuperscript{55} It is a way to bring information to the audience instead of waiting for the audience to come to the information that ultimately increases community interest. “Ideally,” she explains, “the images will be linked back to our website so people can explore more of what we offer.” While Wythe has been vital to the asset management necessary to develop the online collections, Shelley Bernstein, Chief of Technology at the Brooklyn Museum, has been instrumental in connecting that information with the audience by developing the museum’s online persona.

\textsuperscript{54} See Appendix I for Creative Commons BY-NC License
\textsuperscript{55} Wythe, Deborah. Personal Interview. April 15, 2010.
Chapter 5: The Creation of Community

The mantra of the Brooklyn Museum’s Technology department is, “Community first, marketing second.” Instead of viewing social networking and interactive web programs as a necessary means to a marketing goal, like attracting younger audience members, the Brooklyn Museum has internalized the value of creating a living, working, and responding community.

Two current tech projects, Split Second and Click! A Crowd Curated Exhibition illustrate the Museum’s ongoing efforts to invite viewers to interact with the Museum’s collections in innovative and even experimental ways. Split Second asks audience members to make quick judgments of objects in the collection to offer insight into what it is that appeals to the community as well as how those decisions are made. Click! A Crowd Curated Exhibition allows the community to submit the artwork for, as well as curate, an exhibition for the museum.

The Museum’s blog acts as a unifying element for the website as well as the greater Brooklyn Museum community. Most exhibitions, events, and online projects have dedicated blog postings and corresponding comment pages. All staff members are encouraged to contribute information about current projects, not surprisingly, the most entries are by posted by Shelley Bernstein, Chief of Technology, but at 80 contributors, the blog offers a fairly comprehensive look into the Museum. Because the goal is optimal audience engagement, members can even customize their informational experience. Rich Site Summary (RSS) feeds for topics, “Current Exhibitions” for example, are available throughout the website and allow the viewer to create updates tailored to their own interests and have the latest news delivered to a chosen feed reader such as Feed Demon, Newsfire, or Google Reader.

---

Chapter 6: Rights and Reproductions Projects

The Rights and Reproductions team of the Brooklyn Museum is in actuality one committed staff member, whose work, predicated on the remainder of the Digital Lab, brings in an estimated $80,000 annually, 63% from direct requests and 37% from established licensing agreements. With the near collapse of book publishing industry, which brought in regular requests for high-quality, color images for art books, the Museum has been forced to encourage photo-researchers to use the Brooklyn Museum’s collection in new ways. The digitization of the collection has increased exposure, searchability, and ease of use for publishers, and having the collection readily available online for photoresearchers has led to lucrative requests for book cover licenses, which command a higher premium than in-book pages, and film usage.

Rights and Reproductions has also taken advantage of online platforms to expedite the permissions process. The ease of payment combined with the almost instant delivery of funds that PayPal provides has significantly reduced the number of cancellations that previously arose in the interim between inquiry and purchase. The online data sharing site, www.transferbigfiles.com, has also benefited the Museum by simplifying the image delivery process. In addition to image requests, the Museum receives requests for actual objects to be used in film and television. Notably, Female Figurine or Bird Lady, was discovered in the Museum’s online collections and recently featured on the HBO series True Blood.

Rights and Reproduction is also responsible for arranging onsite film shoots with location managers and film scouts. Janson provides images of the Brooklyn Museum which is as diverse in architecture as it is in collections. As well as regularly updating contacts with photographs when new spaces become available, the Museum is also registered with the Association of

57 See Appendices J-M for Rights and Reproductions Materials
Location Scouts and Managers, who liaise between filmmakers and art directors and the owners of potential settings. During the internship the USA series, *White Collar*, rented space to film.

In order to stand apart from other institutions, the Rights and Reproductions Department of the Brooklyn Museum proactively contacts photo editors and art directors. Janson regularly peruses the collections for new objects that should be photographed and added to the online collection for their saleability. The Digital Lab has also begun a practice of frequently tweeting interesting images from the collection that coincide with relevant museum events such as exhibitions and lectures or with more general external events like New York’s firework displays on the Fourth of July. A great benefit of using Twitter is that the Digital Lab is able to track the number of re-Tweets and follow the path and proliferation of the Museum’s objects far into the cyber world.

As a next step in promoting the collection while simultaneously creating more exposure for the brand and strengthening the community, the Brooklyn Museum has begun a WikiSeeding project. The intention of this project is three-fold; to add attribution to the Brooklyn Museum on those images already embedded in Wikiarticles, to replace low quality images of objects in the collection with better ones, and to add new images with attribution lines to those articles that are directly related to objects in the collection. With the ethical red flags this project raises and the dubious reputation that Wikipedia sometimes has, it is possible that the WikiSeeding project could be seen as unwise branding.

Since its inception in 2001, Wikipedia has been at the center of an ongoing epistemological crisis that is eloquently summarized as “either one of the noblest experiments of the internet age or a nightmare embodiment of relativism and the withering of intellectual standards.”58 The criticism that Wikipedia provides incomplete or inaccurate information may at times be true, but even if it is true it is not too distant from Walter Lippmann’s description of

---

print journalism in 1922 as a “chaos of local opinions.” With the increased, almost instantaneous, speed of transmission for information, it makes sense that the process for correcting information would also be accelerated, eventually becoming ever-changing. Notwithstanding this defense of a user-generated information source as an extension of the vetted journalistic process, to say that the concept of an open encyclopedia precludes provenance ignores the fact that there is a multilevel hierarchy within the Wikicommunity that monitors and corrects ostensibly false content and removes heavily biased edits. The seven-person Wikimedia Board appoints 30 Stewards, who review the Bureaucrats, who in turn are able to grant Administrative powers to certain users. There are approximately 1,200 users out of the 4.6 million English language users who have been given the ability to semi-protect or fully protect a Wikipage, and these individuals are zealously committed to protecting the information available in the Wikisphere.

The project does, however, have some serious ethical considerations. Taking advantage of Wiki-proliferation can be construed as misleading the public about the relevance of a museum’s collection by falsly saturating one of the most popular news sources in the world with its own images. To preempt this foreseen problem, the Chief of Technology has urged Brooklyn Museum contributors to adhere to a strict code of ethics while Wikiseeding. Before participating in the project, Museum representatives are briefed about conflict of interest concerns. It is made explicitly clear that edits are to be made under individual accounts that clearly disclose the user’s connection to the Museum. Also, just as Administrator Dan Rosenthal, a 24 year old Iraq war veteran, makes no edits to war related pages with his administrative

60 Dee, J. (2007)
powers, contributors are reminded that no edits should be made to the Brooklyn Museum page or related pages, as it is a violation of the objectivity rules of Wikipedia. Finally, those editing on behalf of the Brooklyn Museum are advised to remain engaged in the Wikipedia community by maintaining open lines of communication before edits are made, and respecting and responding to other editors after they are completed.

In ways the pairing seems ideal. Both the Brooklyn Museum and Wikipedia cite admirable commitments to transparency and a neutral point of view high on their list of values. The improvement of images on Wikipedia not only provides better information to the public, but also bolsters Wikipedia’s reputation and increases the Brooklyn Museum’s exposure. The sheer power of numbers bodes well for the Brooklyn Museum. An astounding one in every 200 page views on the expanse of the internet is of a Wikipedia page. As long as the Museum remains conscious of possible conflicts of interest and implements and adheres to a sound system for checking edits, the Wikiseeding projects offers an unprecedented opportunity to increase the Museum’s audience by attracting attention in an unconventional educational setting.

---

61 Dee, J. (2007)
Chapter 7: Attracting a Diverse Audience

It has been suggested that the Brooklyn Museum’s closest competitor is The Metropolitan Museum of Art.\textsuperscript{63} The Met, on Fifth Avenue in the heart of Manhattan’s Museum Mile, was founded on April 13, 1870, "to be located in the City of New York, for the purpose of establishing and maintaining in said city a Museum and library of art, of encouraging and developing the study of the fine arts, and the application of arts to manufacture and practical life, of advancing the general knowledge of kindred subjects, and, to that end, of furnishing popular instruction.\textsuperscript{64} While there are similarities in architecture and collections, the differences between these museums are striking. The Brooklyn Museum could not and does not try to compete with The Met’s central location, affluent neighborhood, and staggering five million annual visitors, and thus needed to define its own niche. In its efforts to distinguish itself, the Brooklyn Museum did what any savvy institution should do: it evaluated the needs of its constituents and adjusted its values and mission.\textsuperscript{65} In particular, administrators at the Museum looked to its neighbors and realized that the community surrounding the Brooklyn Museum was vastly different from that of the Met.

Director Arnold Lehman felt, that as with any institution funded by tax payers’ money the Brooklyn Museum had and has an obligation to adequately represent and serve its population.\textsuperscript{66} Brooklyn’s 2.6 million residents are younger and more diverse than their Manhattan counterparts; however, the average museum goer was a 58 year old white female.

\textsuperscript{64} Charter of The Metropolitan Museum of Art, State of New York, Laws of 1870, Chapter 197, passed April 13, 1870 and amended L.1898, ch. 34; L. 1908, ch. 219.
\textsuperscript{66} Lehman, A
The most recent census numbers show that Kings County, New York—the federal equivalent of the borough of Brooklyn—has a population that is 42.8% white, 34.3% black or African American, and 10.5% Asian.\textsuperscript{67} Through strategic exhibition planning, programming, and community building the Brooklyn Museum has strived to attract an audience that reflects the diversity of population it serves. Indeed, its audience demographics now show an appropriate distribution across age, sex, and race, recently reporting that the average visitor is 34 years old and the non-white portion of its audience is 45%, an accurate portrayal of what is present in the community at large.\textsuperscript{68} The Brooklyn Museum has succeeded in identifying itself with a young, vibrant community, which is often a difficult task for century-old institutions housing ancient artifacts.

In order to attract this audience, the Brooklyn Museum has been assisted by controversy. In 1999, the Museum received a boost in recognition as it underwent a federal trial concerning freedom of expression. Sensation, the aptly named exhibition of work by the group known as YBAs, Young British Artists who were discovered and promoted by British collector Charles Saatchi, caused a violent reaction from some in the public and then mayor Rudolph Giuliani. Amidst cries of outrage concerning Chris Ofili’s painting of the Virgin Mary, Giuliani cut government funding to the Museum. The funding was eventually restored, but weathering what could have been a media frenzy with catastrophic consequences for the Brooklyn Museum left Lehman with a new understanding of the power of the press. He now warns that while they are “not owed an explanation, the media will always make its own story.”\textsuperscript{69} In addition to winning the case, the Brooklyn Museum saw an upturn in the number of visitors to the exhibition and an increase in the time spent in the galleries, an average of 3-6 hours.

\textsuperscript{68} Lehman, A. (2010)
\textsuperscript{69} Lehman, A. (2010)
Shows such as Hip-Hop Nation in 2000, brought a form of cultural expression familiar to the teens and young adults of Brooklyn inside the walls of the Museum. Lehman describes the show as a breakdown of the “disconnect outside and inside of the museum.” The show was in fact innovative in that it was the first of its kind in a prestigious art institution, and did succeed in drawing in crowds of young viewers; however, it may have alienated some of its older members.

The Brooklyn Museum is again causing rumbles within the art community, this time instead of a controversy surrounding its exhibitions, it is facing criticism for its overly populist appeal. In 2010, the Museum partnered with the Bravo channel for the television show Work of Art: The Next Great Artist. From a financial standpoint, the partnership was very beneficial, by offering the winner of the show an exhibition in a small gallery after the final episode, the Museum received a great deal of nationwide coverage, but one has to wonder what the museum sacrificed in brand identity. The work of Abdi Farah, the 22 year old winner of the show, was met with very little praise, and even more questions were directed at the venerable institution that offered him a show. Despite the fact that Charles Desmarais, Deputy Director at the Museum, cites the long standing tradition of juried art exhibitions as precedent for the Brooklyn Museum’s involvement in the show, it does not sit well with many art critics and artists that the artistic process was trivialized and commercialized on the show.

Making artwork and the art world accessible to new audiences is an admirable goal, but it is necessary for an arts organization to take care not to stray too far from its original intent and lose its aim. Museums as educational institutions not only preserve the past and depict the

70 Lehman, A. (2010)
present, but they must also enter into dialogues with the audience that challenge assumptions and catalyze new thoughts. It is a moment of disruption or the “crisis of knowledge” that begins the learning process. 73 If a museum only presents artwork with which a culture is familiar, or what has been validated by 1.2 million television viewers, then they are failing to act as a performative site where viewers create new cultural myths and instead are simply regurgitating an institutional monologue. 74 It is too soon to tell what effect the partnership with Bravo will have on the Brooklyn Museum, but for now as a testament to his devotion to an egalitarian public, Lehman is driven more by the support of bloggers than the criticism of journalists.

Chapter 8: SWOT Analysis with Reference to Best Practices

**Strengths**

*Financial Standing*

With a net income of $9.9 million, the Brooklyn Museum demonstrates a deft ability to generate and distribute funds to effectively balance its budget. Income is generated through both traditional development efforts, which equal 89.9% of total revenue, and earned revenue streams, which equal 10.1% of total revenue. While it could be greater, this diversification of funds provides greater financial stability than total reliance a single funding method.

As a testament to the Brooklyn Museum’s positive standing with the public, funding from individuals in the form of Membership dues, Admission and Exhibition fees, Fundraising events, and Individual contributions totals $14,229,747, 34% of total revenue.

In addition to contributions and service fees, the Brooklyn Museum wisely utilizes its physical space to earn additional revenue from event rentals and film projects.

*Communication*

Because clear and direct communication guides so much of the museum’s public face, it is not surprising that it is highly valued within the organization as well. As an intern I met regularly with my supervisor. We had a dedicated 20-30 minute meeting every two weeks, so I never had to vie for her attention when there was a problem or prolong issues while waiting for a decision. As a department we met for monthly staff meetings that began with a round of updates from all co-workers, so everyone on the team was informed of what everyone else was doing. There is a dedicated space on the break room board for non-urgent problems to be recorded as they arise throughout the month. The staff addresses, discusses, and tries to resolve all of these issues during the staff meeting. The staff is also provided with the minutes from the divisional
meetings to keep us updated about what is happening in other departments and to give the work of the Digital Lab greater context.

In order to address larger issues, the administration relies on interdepartmental committees. By opening up these discussions to a range of individuals, the Museum has a better chance of finding a viable solution to its challenges.75 One current issue is the Museum’s newly expanded hours. Because attendance to the extended hours has not been as high as expected, the administration has asked for employee input, reviewed the suggestions, and formed 4 cross departmental teams to address identified key issues: Internal Communication, Environmental Scanning, Measurement, Audience Building.

This dedication to communication, complete with channels for feedback and regular updates, has created a staff with a unified vision. Even with 350 employees, I felt like the goals of the staff were more aligned than I have experienced in organizations with only 4 employees that lack proper communication channels.

Organization

The Digital Lab, perhaps not surprising of an archive, is thoroughly organized. Employee roles are well-defined. Files are clearly and consistently labeled for storage both physically and electronically. All out-going license requests are sent through a permanent employee to create continuity for contacts. Additionally, all updates to the research database and all files are assigned an author so they are easily traceable. Every procedure in the Digital Lab is systematized, but to avoid stagnation processes are often revisited to make sure that they are functioning optimally.

**Programming**

The Museum offers a range of educational programming geared to the spectrum of development from infants to adults. Attendance at special programs is satisfactorily high and tends to be increasing. The Museum is stationed as an institution that grows with the family.

**Use of Technology and Community**

The Museum’s Technology department has embraced the use of current technological advances. Regularly updated content on Flickr, Twitter, Tumblr, Youtube, Yelp, Foursquare, and Wikipedia make the Brooklyn Museum’s community almost omnipresent on the web. The mantra, “Community not marketing” is pervasive throughout the Museum. Inquiries to the staff of the Brooklyn Museum are answered quickly and thoughtfully, and all staff members are more than willing to share insight into the functioning of the Museum, which illustrates the genuine desire to remain engaged with the audience and maintain two way communication.

**Exhibitions**

The Brooklyn Museum has a history of noteworthy exhibitions. Shows such as *Graffiti* and *Hip Hop Nation* have been lauded as landmarks for bringing street culture into a prestigious institution. *Sensation* gained national attention and set important precedents for art organizations’ freedom of speech. The Brooklyn Museum also boasts one of the nation’s largest collections of Feminist Art.

**Copyright Clearance**

The Brooklyn Museum is dedicated to creating an easily accessible, comprehensive online collection, and in order to do so, is undertaking the extensive process of obtaining nonexclusive licenses for all works in the collection that may be protected by copyright. The
commitment to this project demonstrates a dedication to transparency as well as an attempt to establish a practice that other institutions can replicate in the future.

Weaknesses

**Copyright Clearance Database Not Available to Others**

Despite the fact that the Brooklyn Museum envisions this project helping other institutions undertake the task of finding rights-holders and securing licenses to expand their own online collections, it is not currently available to parties external to the Museum.

**Lack of Safeguards for Artist Rights**

Artists who agree to be included in the Museum’s Collections on the Web receive very little assurance that their images will not be copied and distributed illegally. The Brooklyn Museum has fulfilled its legal obligation by procuring licenses for the use of images.\(^76\) this is negative for the Museum in two ways: it lessens the likelihood that an artist will be willing to license use of his or her images to the Museum, and it also betrays the Museum’s dedication to respecting artists’ rights.

**Updates to Copyright Clearance Manual**

While it is very detailed, the Copyright Clearance Manual is lacking some key features including definitions, search terms, and communication methods that would improve performance.

**Confusing Online Collections**

While the rest of the website is clean, consistent, and easily navigable, when one logs on to the collections page, the overwhelming amount of information available seems unorganized. The option to visit an established collection of the Museum is there; however, the links are small and easily dismissed on a neutral gray bar. The attempt to make the works in the collection

\(^76\) Hirtle, P. (2009)
sortable by common, user-generated descriptors, is unsuccessful. Instead of offering a novel look at the Museum’s collection, the concentration of thumbnails make the page cluttered and confusing.

**Weak Curatorial Voice and Populist Appeal**

After its foray into cable television on Bravo, the Brooklyn Museum has suffered criticisms that it is overly populist. The Brooklyn Museum has also been criticized for importing more shows than it produces.\(^77\) Both issues are worrisome as they indicate a weakening of the artistic direction within the Museum. A curatorial voice should be guiding the organization through shows that not only generate revenue, but also further the institution’s mission.\(^78\)

**Opportunities**

**Publicly Searchable Database**

The Digital Lab has the opportunity to create a very useful resource for the public and other nonprofit organizations by making the Copyright Clearance research database public.

**Wikiseeding**

By attributing images on Wikipedia to the Brooklyn Museum’s collection, the Museum has the opportunity to increase its exposure on the web immensely.

**Threats**

**Decline in Brand Equity**

A continued decline in the quality of exhibitions at the Brooklyn Museum will invariably lead to failure of the institution.

---


**Staff Morale**

At times the morale of the staff seemed depressed. This is a minor problem in the Digital Lab that arises from staff schedules. On a larger scale, I witnessed an upset when the administration announced that it would be leasing the parking lot and increasing parking fees. A workforce that feels mistreated is unlikely to perform well.79

**Location**

While the Brooklyn Museum is centrally located for the borough of Brooklyn, it is often off the radar for visitors to New York. There is little the Museum can do to change this situation; however, it could create a partnership with the established institutions on Manhattan’s Museum Mile. Not only would a partnership of this nature be in line with the Brooklyn Museum’s notion of community, but it would also would increase exposure and attract more visitors.

---

Chapter 9: Conclusion

Contributions and Outcomes of the Internship

The experience of working as a Copyright Clearance Intern at the Brooklyn Museum was a truly rewarding experience. In addition to contributing to the broader goals of the museum, on a daily basis the project was always engaging, never boring, as I researched artists, their works and lives. In quantifiable terms, throughout the internship, I located rights-holders and sent licenses for 831 works to over 100 artists and estate representatives, began meaningful research on over a 100 more, and received licenses for 303 works by 36 artists. As of December 2010, this number represented 6% of the total works cleared by 10% of the artists who had responded to date.

The Brooklyn Museum was also very pleased with the internship. As a result of the internship, I have been offered a position at the Brooklyn Museum.

Recommendations

My internship with the Brooklyn Museum was limited to the fairly narrow scope of Digital Collections and Services with a few well-defined daily tasks. In contrast to many of the small or budding arts organizations that I have had the pleasure of working with in the past, the Brooklyn Museum is a very large institution that has been vetted by over a hundred years of operations. While many arts organizations grapple through budget constraints, staffing challenges, lack of resources, unfamiliarity with current technology, general miscommunication and disorganization, and lack of planning, the Brooklyn Museum has a strong funding base, educational programming for the entire family, an exhibitions schedule that attracts an appropriately diverse audience, solid legal standing, and a well-defined, dynamic, and engaging

---

80 See Appendix 0 for Internship Evaluation
brand identity. Digital Collections and Services, where I had the joy of spending the majority of my time, operates in an extremely well organized manner and open communication is encouraged. The Copyright Clearance project that I took part in is not only an admirable, pioneering step toward greater transparency and functionality in the collection, but is also meticulously planned.

There is of course always room for improvement. My recommendations for the Brooklyn Museum address procedural issues and next steps for the Copyright Clearance project, staff morale, and branding of the institution.

**Copyright Clearance Manual**

The copyright clearance manual serves as an excellent guide for incoming interns as it quickly familiarizes one with the user interface of TMS and the research database in Access. It also provides step by step guidance from setting up a workspace through researching artists to generating the appropriate reports and creating licenses. I saw the value of having such a detailed manual because it makes what would be a complicated process easily replicable and consistent through a chain of incoming interns. I would make several specific additions to the manual.

There were inconsistencies throughout the database regarding the number of works attributed to an artist, and these variances in number will no doubt affect later assessments of the progress of the Copyright Clearance project. To rectify this problem, I would edit the section, “Tracking Your Work,” to add that the number of works attributed to an artist should be only the number of works in need of clearance rather than all of the works by that artist in the collection. Since this database tracks the number of cleared works in relation to the number of works still under copyright, it makes sense to exclude those works subject to no copyright restrictions such as those created before 1923 or as works for hire.
In order to generate the necessary reports, it is possible to create object packages of only those works protected by copyright. Because these object packages work by narrowing the results for a given search term, they obfuscate files that may be needed at a later date. Despite the fact that these object packages can interfere with subsequent searches, I found many out of date object packages in TMS. I would update “Working with TMS” to include a final instruction to delete all object packages that were created to assist in the running of reports.

Through the practice of researching the artists in the IMLS grant, I was able to identify a number of useful search terms that I would add to “Identifying and Locating Rights-holders.” *Obituary, Death, Died,* and *Heirs* were useful for quickly finding references to online obituary notices and wills. *Artist Exhibition,* and *Representative* were helpful for finding gallery and estate representatives.

Finally, I would add a section to the manual called “Making Contact.” There is no proscribed plan in the manual for communicating with contacts after they have been located. In my experience training another intern, I found that it would be helpful to outline communication standards. The nature of this research is such that many times the contacts are elderly and unfamiliar with email, and the nature of the project is such that many contacts are unfamiliar with the information we are requesting, so I found that the most effective method of communication was a quick, friendly phone call introducing the project followed by a more detailed email or letter depending on the contact’s preference. A preliminary phone call was also more effective with galleries as it alerted them to incoming paperwork rather than the request being lost or ignored in an inbox.
Survey

I would like to see the Brooklyn Museum include a survey of understanding with the cover letter and nonexclusive license. With this information, Digital Collections could address sources of confusion on the website as well as in educational presentations. The survey would also give insight into the reasoning of those individuals who decline to sign the nonexclusive license or to be included in the online collections.

Image Tracking Software

Because respecting the rights of artists is so highly valued in the goals of the Copyright Clearance project, the Brooklyn Museum needs to be doing more to protect artists who are gracious enough to allow their works to be displayed in high resolution on the Museum’s website. A subscription to an image tracking service such as PicScout would be ideal; however, if cost is prohibitive, there are a number of free services that could be implemented that would provide a greater degree of protection than is currently in place.

Searchable Copyright Database

The Brooklyn Museum currently encourages other institutions to seek out the copyright holders for works in their collections and develop more complete online collections. To support these endeavors, the Brooklyn Museum also offers copies of nonexclusive licenses, details of the process and how it can be replicated, and individual rights-holder information. The next logical step for the Copyright Clearance project is to make the entire database searchable and open to the public. The Brooklyn Museum can emulate the model that has been established by the University of Texas at Austin and University of Reading with the WATCH file. This open database would fulfill the Museum’s commitment to transparency of information and further its educational goals.


**Parking Lot Fees**

The Brooklyn Museum’s recent decision to lease the parking lot to a third party and increase parking fees is an unnecessary cost to the staff and an unneeded cut to staff morale. Given the Museum’s financial stability it is an unwise decision to pass this expense on to the staff. The directive to make personal financial sacrifices—especially ones that could easily be assumed by the organization—is difficult to accept when it comes from an individual earning ten times the average salary. The museum should listen to the organized dissatisfaction with the decision and not increase parking fees.

**Protecting Identity**

In its efforts to define a niche as a young approachable institution, the Brooklyn Museum has made several compromises to its brand identity including promoting substandard artwork as part of user-generated exhibitions and partnering with cable television to find the next great artist. The Brooklyn Museum should be a part of its community and create programming that is interesting to and reflective of its population, however, there is a line at which accessibility becomes pandering and good taste is overrun by popular opinion. While the Bravo partnership has been good for numbers, it is not beneficial for the Museum’s reputation. If the Museum wants to increase buzz with new artists, the curatorial staff should organize a regular schedule of small exhibitions of emerging artists discovered in the local art scene not those selected based on commercial appeal.

The issue of user generated content walks a fuzzier line. Encouraging the general public to participate in exhibitions, submit artwork, and respond to work can lead to the curatorial voice being overrun by screaming masses, but this democratization is part of a noble effort to make art consumable. As long as clear lines can be drawn between the official and the audience, the
public gains the benefit of the creative exercise, people are exposed to more information and free
to make their own judgments, and there is no threat of the museum suffering the ill effects of
weak curating.

I have heard the Brooklyn Museum described playfully as the “hip, friendly museum in
New York; the one that you want to get a drink with.” This depiction suits the Brooklyn Museum
well: it is approachable, open to changing trends, welcoming of a good time, but as it continues
to push boundaries with the development of its online community it should continue to ask itself
“Do you trust that person?” “Do you respect that person?” and keep in mind that the distinction
between fun inclusivity and unrespectable excess has so much to do with editing. More than
anything, the Brooklyn Museum needs to ensure that it does not become the city’s rambling
drunk.
Bibliography


ARS. “About Artist’s Rights Society.” Accessed online: http://www.arsny.com/about.html


Charter of The Metropolitan Museum of Art, State of New York, Laws of 1870, Chapter 197, passed April 13, 1 and amended L.1898, ch. 34; L. 1908, ch. 219.


Creative Commons. “What is CC.” Accessed online April 2010 http://creativecommons.org/about/what-is-cc.


Greenblatt, Harmon. Arts Administration Lecture. 2008


Kelly V. Arriba Soft Corp. 336 F. 3d 811 case found on the Westlaw electronic database. 2010


Perfect 10, Inc. V. Google, Inc. , 2007. 487 F.3d 701. case found on the Westlaw electronic database. 2010

PicScout-Every Image Gets Its Credit.”Image Tracker FAQ” Accessed online:
http://www.picscout.com/faq/imagetracker-faq.html#IT6


United States Copyright Code. 17 U.S.C. § 107


WATCH File. “About WATCH.” Accessed online: http://tyler.hrc.utexas.edu/about.cfm


Appendix A: Brooklyn Museum Organizational Chart
DESIGNATED AREAS
The following areas are available for private events:

*Martha A. and Robert S. Pavilion and Lobby, 1st floor*
  - Capacity: 1,000 for standing cocktails, 300 for seated ceremony, 100 for seated dinner

*Glass Corridor, 1st floor*
  - Capacity: 100 for standing cocktails, 60 for seated dinner

*Museum Café, 1st floor*
  - Capacity: 100 for seated dinner

*The Beaux-Arts Court, 3rd floor*
  - Capacity: 1,000 for standing cocktails, 700 for seated dinner and dancing

*The Iris and B. Gerald Cantor Auditorium, 3rd floor*
  - Capacity: 460, permanent seating

*The Iris and B. Gerald Cantor Gallery, 5th floor*
  - Capacity: 250 for standing cocktails, 120 for dinner

*Steinberg Family Sculpture Garden*
  - Capacity: 350 for standing cocktail reception, 200 for seated ceremony

Please be advised that all spaces, excluding the Rubin Lobby & Pavilion and the Cantor Auditorium, are **NOT** air-conditioned.

Dates and availability subject to change

FEES
The Museum charges the following fees in connection with all standard private events:

  a. **Space Use fee – $5,000.00**

     Space use fee for a ‘standard event’ is $5,000. A ‘standard event’ is any event attended by up to 250 guests for the duration of 5 hours or less. The Use Fee may be further increased by the Museum to reflect other non-standard aspects of the event. If it is necessary for an event to load-in or set-up during another calendar day, the User will be charged an additional day’s Use Fee of $5,000, or portion thereof.

     For use of the Cantor Auditorium only, the space use fee is $2,500. If it is necessary for an event to load-in or set-up during another calendar day, the User will be charged an additional day’s Use Fee of $2,500, or portion thereof at the discretion of the Museum. Use of the Cantor Auditorium in addition to another Museum space is subject to standard Space Use fee of $5,000.

     Federally recognized not-for-profit organizations are eligible for the 20% NFP discount. Valid 501(c)3 certification is required upon submission of application.

  b. **Staff Fees – approximately $5,000.00**

     Staff fees for security, maintenance and technicians that the Museum incurs in connection with the event. The estimated fee for a standard event is $5,000.

     Any event incurring staff fees in excess of $5,000 will be considered a ‘nonstandard’ event, and the applicant will be billed for such fees subsequent to the event.

  c. **Membership Fee - $350.00/$250.00**

     If the applicant is not already a member at the Patron-level or higher, the Museum requires that the applicant join the Museum at the Patron-level. ($350)
If the corporate/non-profit applicant is not already a member at the Donor-level or higher, the Museum requires that the corporate applicant join the Museum at the Donor-level. ($250)
The Museum may charge the following additional fees if applicable:

d. **Additional Guest Fee**

Events with an expected guest list of more than 250 guests are subject to a charge of $10 fee for each guest.

e. **Time Extension Fee**

Events concluding after midnight will incur a time extension fee of $1,000 for each hour or portion thereof that the event continues, as well as additional staff fees.
Appendix C: Brooklyn Museum Income Statement

Revenue

<table>
<thead>
<tr>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Membership dues</td>
<td>$843,851.00</td>
</tr>
<tr>
<td>Fundraising events</td>
<td>$420,159.00</td>
</tr>
<tr>
<td>Governmental grants</td>
<td>$26,113,391.00</td>
</tr>
<tr>
<td>Other contributions</td>
<td>$11,236,795.00</td>
</tr>
<tr>
<td>Exhibit Fees</td>
<td>$985,033.00</td>
</tr>
<tr>
<td>Admission Fees</td>
<td>$743,909.00</td>
</tr>
<tr>
<td>Educational Programs and Space Use</td>
<td>$508,755.00</td>
</tr>
<tr>
<td>Parking Lot Fees</td>
<td>$84,838.00</td>
</tr>
<tr>
<td>Investment Income</td>
<td>$2,594,711.00</td>
</tr>
<tr>
<td>Sale of Assets</td>
<td>-$4,271,842.00</td>
</tr>
<tr>
<td>Sale of Inventory</td>
<td>$1,246,397.00</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>$1,091,144.00</td>
</tr>
</tbody>
</table>

Total Revenue: $41,527,798.00

Expense

<table>
<thead>
<tr>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compensation of current officers, directors,</td>
<td>$1,180,545.00</td>
</tr>
<tr>
<td>trustees, and key employees</td>
<td></td>
</tr>
<tr>
<td>Other Salaries and Wages</td>
<td>$14,446,402.00</td>
</tr>
<tr>
<td>Pension Plan Contributions</td>
<td>$674,064.00</td>
</tr>
<tr>
<td>Employee Benefits</td>
<td>$3,044,124.00</td>
</tr>
<tr>
<td>Payroll Taxes</td>
<td>$1,417,414.00</td>
</tr>
<tr>
<td>Legal Fees</td>
<td>$155,964.00</td>
</tr>
<tr>
<td>Accounting Fees</td>
<td>$103,370.00</td>
</tr>
<tr>
<td>Fundraising Fees</td>
<td>$50,000.00</td>
</tr>
<tr>
<td>Investment Management Fees</td>
<td>$166,583.00</td>
</tr>
<tr>
<td>Other Fees Paid to Non-Employees</td>
<td>$1,310,770.00</td>
</tr>
<tr>
<td>Advertising and Promotion</td>
<td>$577,140.00</td>
</tr>
<tr>
<td>Office Expenses</td>
<td>$2,499,068.00</td>
</tr>
<tr>
<td>Travel</td>
<td>$564,781.00</td>
</tr>
<tr>
<td>Depreciation, Depletion, and Amortization</td>
<td>$3,351,948.00</td>
</tr>
<tr>
<td>Insurance</td>
<td>$282,429.00</td>
</tr>
<tr>
<td>Acquisition of Works</td>
<td>$948,641.00</td>
</tr>
<tr>
<td>Category</td>
<td>Amount</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Exhibitions Fees</td>
<td>$239,807.00</td>
</tr>
<tr>
<td>Research and Curatorial</td>
<td>$218,726.00</td>
</tr>
<tr>
<td>Design Materials</td>
<td>$154,192.00</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>$181,040.00</td>
</tr>
<tr>
<td><strong>Total Expenses</strong></td>
<td><strong>$31,567,008.00</strong></td>
</tr>
<tr>
<td><strong>Net Income</strong></td>
<td><strong>$9,960,790.00</strong></td>
</tr>
</tbody>
</table>
Appendix D:
Brooklyn Museum Copyright Clearance Process Overview

1. Select an artist whose works need to be cleared.

2. Research to identify and obtain contact information for rightsholder(s): the orphan works checklist is a good place to start. Add a record to the Access database to indicate the artist is being researched and add status updates as you progress (statuses beginning with 1). Rightsholders are typically identified as:
   - artist (if alive and rights not assigned to others)
   - estate of the artist (heirs) (if dead and rights not assigned to others)
   - others

3. Once the rightsholder has been found, generate an object package in TMS for the works needing clearance.

4. Generate two reports from TMS:
   - Copyright Object Info (from main object page) – Editable RTF file
   - Non-Exclusive License (from Registration > Accessioning page) – Editable RTF file

5. Use the RTF files generated above to create a license and cover letter(s) in Word.

6. Submit the license and cover letter(s) to Deb for signing/sending.

7. Add a record to the Access database to indicate the license request has been sent (status 31).

8. If no license has been received (or denied) after six months or so, send a follow-up letter. Add a record to the Access database to indicate a follow-up has been sent (status 42).

9. When a license is received:
   - Make a paper copy of the license and file both the original and the copy
   - In TMS, pull up the object package from step 3 above and update the Object Rights Type for all works
   - Create and send a thank you card and envelope
   - Add a record to the Access database to indicate the license has been received (status 91 or 92)

10. If a license has been denied:
    - In TMS, pull up the object package from step 3 above and update the Object Rights Type for all works
    - Add a record to the Access database to indicate the license has been denied (status 93 or 94)

11. If you cannot locate a rightsholder:
• Complete the orphan works checklist for the artist and submit it to Deb
• Add a record to the Access database to indicate the artists' works are suspected orphans (status 81)
• When the orphan status has been confirmed, generate an object package in TMS for the works needing clearance and update the Object Rights Type for all works
• Add a record to the Access database to indicate the artists' works have been declared orphaned (status 99)
April 29, 2011

(Contact)
(Address)

Dear (Contact):

The Brooklyn Museum is honored to have in its collection the following work(s) of art which (Name of Artist) created and whose estate you manage:

List of Works

We are currently going through a process to make sure our paperwork is complete and find that we do not have a non-exclusive license form on file for the works of (Name of Artist).

While ownership of a work of art gives the Museum the right to do a variety of things, it does not transfer copyright, which the artist’s estate retains. The non-exclusive license will grant us permission to use images of the work for Museum-related activities.

We look forward to receiving the signed document at your earliest convenience. Alice Cork, our project intern, or I would be happy to assist if you have any questions. Please do not hesitate to contact us.

Sincerely and with many thanks,

Deborah Wythe
Appendix F: Sample Cover Letter to Artist

April 29, 2011

(Contact)
(Address)

Dear (Contact):

The Brooklyn Museum is honored to have in its collection the following work(s) of art which (Name of Artist) created and whose estate you manage:

List of Works

We are currently going through a process to make sure our paperwork is complete and find that we do not have a non-exclusive license form on file for the works of (Name of Artist).

While ownership of a work of art gives the Museum the right to do a variety of things, it does not transfer copyright, which the artist’s estate retains. The non-exclusive license will grant us permission to use images of the work for Museum-related activities.

We look forward to receiving the signed document at your earliest convenience. Alice Cork, our project intern, or I would be happy to assist if you have any questions. Please do not hesitate to contact us.

Sincerely and with many thanks,

Deborah Wythe
Appendix G: Sample Non Exclusive License

Please see attached pages for complete list of artworks.

I, the undersigned, acknowledge that the Brooklyn Museum (the “Museum”) has in its collection the above referenced work(s) (the “Work”), and that the Museum requests permission as described below concerning the Work for purposes consistent with its charitable and educational mission. I understand that the Museum is a not-for-profit, educational corporation dedicated to the primacy of the visitor experience and committed to excellence in every aspect of its collections and programs. Among the specific goals of the Museum is to serve its diverse public as a dynamic, innovative and welcoming center for learning through the visual arts.

In light of the Museum’s charitable and educational mission, and in recognition of the Museum’s lawful possession of the Work, I hereby grant to the Museum, as of the date written above, a non-exclusive license (the “License”) to reproduce the Work, for the life of its copyright and any renewals or extensions thereof, in any media whether now known or invented after the date hereof (all reproductions, the “Images”), and to display, transmit, publish, distribute, prepare derivative works of and otherwise use the Images throughout the world as follows:

1) in educational materials related to the Museum’s collection and programs (including, for example, posters, postcards, teaching materials, web sites, social networks, catalogues and similar publications, some of which may be offered through Museum’s stores); and
2) in publicity and informational materials about the Museum’s collection and programs (including, for example, press releases, web sites, social networks, annual reports, promotional flyers, email, posters or films, and membership solicitations).

I agree that the License expressly authorizes the Museum to sublicense the specific rights granted herein to third parties.
as necessary (in the discretion of the Museum) to fulfill its mission. For all other rights, I understand that the Museum shall seek permission from me or my representative and that it will direct inquiring third parties to do the same. The License is binding on my heirs, administrators, executors, successors and assigns.

Whenever feasible, the Museum shall include (and cause others to include) the following copyright notice, or one similar to it, in connection with Images:

© (Artist/ Estate of Artist)

I affirm for the Museum that I am the sole and exclusive owner of the copyright to the Work and therefore able to grant the License, as requested herein.

Signature ________________________________

Printed Name ________________________________

(If not Artist) Relationship to Artist _________

Date ______________
Copyright Clearance Process Manual

Last Update: April 29, 2011
# Table of Contents

- Project Description ................................................................. 64
- Initial Setting Up ................................................................. 66
- Tracking Your Work ............................................................... 69
- Working with TMS ................................................................. 79
- Identifying and Locating Rightsholders .................................. 95
- Generating a License Request .............................................. 97
- Following Up on Previous License Requests ....................... 115
- Processing a Signed License ............................................... 116
- Appendix ............................................................................. 120
Copyright clearance at the Brooklyn Museum is performed to obtain permission from artists and other rightsholders for the museum to reproduce and distribute images of artworks in its collection in order to further the museum's charitable and educational mission. This clearance is necessary because physical ownership of a work is not the same as ownership of copyright in that work, and collectors (including museums) usually do not hold copyright in the works they acquire (or sell). Ownership of copyright is generally held by the creator, his/her heirs or other designated rightsholders or, in the case of works for hire, by the employer.

The Brooklyn Museum seeks clearance in the form of a nonexclusive license, which allows the rightsholder to retain the right to enter into similar arrangements with other parties (an exclusive license would mean that the rightsholder surrenders that right). We have a boilerplate license, which sometimes gets amended by the rightsholder before he/she signs it. An amended license is called a "restricted" license in Brooklyn Museum's records.

For accessions from 2008 onward, the various curatorial departments are obtaining clearances from rightsholders. Digital Collections and Services (a/k/a the "Digital Lab") is working on the backlog of works accessioned before 2008. Note, however, that any requests for copyright clearance should include all works, regardless of accession date, for which the rightsholder owns copyright. Also note that some works may eventually be declared "orphans," meaning that no rightsholder could be located despite a reasonably diligent search.

What Works Are Included in the Licensing Project?

1. Works created 1923 or later which are also two dimensional works or video works
2. Works which are "Deaccessioned" but still located in BM
3. Works which are temporary loans to BM
4. Works which BM has loaned out (location = "Out of BMA" but work is neither "Deaccessioned" nor "Returned to Lender")

What Works Are Not Included in the Licensing Project?

1. Works created before 1923
2. 3D works
3. Works which are both "Deaccessioned" and "Out of BMA"
4. Works which are both "Returned to Lender" and "Out of BMA"
5. Works by artists who are represented by either ARS or VAGA, two organizations which handle copyright on behalf of artists

What Steps Need to be Performed for Copyright Clearance?

1. Continually track progress to document our work via the Digital Collections and Services Access database; this is particularly important for works that may eventually be declared "orphans"
2. Identify rightsholders: artists/estates/heirs/others
3. Obtain contact information for rightsholders
4. Generate and send license requests using The Museum System (TMS), Word, and Excel
5. Follow-up license requests when there has been no response
6. Process signed licenses, including sending thank yous to licensors
Initial Setting Up

File Locations
1. All files for the copyright project are located in My Documents\PROJECTS\copyright:
   • Note that "My Documents" is equivalent to "\\darjeeling\digitallab"
   • main directory area primarily contains the Access database for tracking your progress, named CopyrightResearch.accdb
   • \license and correspondence contains license requests (licenses and letters)
   • \reference contains reference materials, such as this manual, lists of artists represented by ARS or VAGA, a checklist for declaring a work orphaned, and files recording artist contact information we have sent to the online WATCH File at http://tyler.hrc.utexas.edu/. The WATCH File is a shared database of artist contact information which is jointly maintained by the University of Texas at Austin and the University of Reading
   • \templates contains template files (.dot) for licenses and letters
   • \working files contains various files generated in the course of our work

Set Up a Folder for Your Working Files
1. Create the folder: My Documents\PROJECTS\copyright\working files\[yourname]'s work

Set Up Microsoft Word
1. Click on the Word icon in the upper left ( )
2. Click on Word Options on the bottom right of the menu
3. Click on Advanced and scroll down to click on File Locations under General
4. Modify the "Documents" location to point to My Documents\PROJECTS\copyright
5. Modify the "Workgroup templates" location to point to My Documents\PROJECTS\copyright\templates

Modify the Templates to Include Your Name as a Contact
1. From Explorer, navigate to My Documents\PROJECTS\copyright\templates
2. Right click on each of the highlighted files below and choose Open (do not double click them to edit them)
Find the name of the "intern" in each letter and replace it with your name. Save each file.

**Set up Microsoft Excel**

1. Click on the Excel icon in the upper left (_excel_icon.png)
2. Click on Excel Options on the bottom right of the menu
3. Click on Save and modify the "Default file location" in the "Save workbooks" section to `\darjeeling\digitallab\PROJECTS\copyright`

**Set up Microsoft Access to Include Yourself on the BMA Staff List**

1. Open Access, and open the CopyrightResearch database in My Documents\PROJECTS\copyright\`
2. On the navigation pane on the left, make sure you are in Copyright DB Management View. Expand the "Reference" section and open the "BMA Staff" table by highlighting it and double clicking or hitting <Enter>: 
3. At the bottom of the table, next to the asterisk, add your name and hit <Enter>.

4. Close the BMA Staff table and close up the Reference section.
You will need to keep track of your progress using the Access database,

My Documents\PROJECTS\copyright\CopyrightResearch.accdb

There are four main ways to enter information. See the Navigation Pane on the left, Copyright DB Management View, under "Input":

1. "Artists" and "Contacts" allow you to enter new artists and contact information in a table (spreadsheet).

   a. Artists are listed in alphabetical order by the last name (under "Filed Under") that has been defined in TMS. The rightsholder is often the artist or "Estate of" the artist for deceased artists.
To add an artist, click on the "New Record" icon ( ) and fill in all information.

b. Contacts are listed in alphabetical order by the first word in the contact name.

c. Especially for contacts, you should make sure the name has not already been entered – note that for galleries we list contacts by gallery name, not by staff name. The database won't allow you to enter exact duplicates, but you should still check in case the name could be typed two different ways (PPOW and P.P.O.W., for example, would be stored as two separate contacts, which we don't want). Either scroll through the entire list or perform a search, using variations in spelling as in the PPOW example, using the search box at the bottom:
2. To track progress, you will be adding "updates" associated with the artist. In general, what you are trying to track are steps in the process of getting a license – dates we've contacted people/organizations to see if they represent the artist, dates we've obtained artist contact information (not always by contacting people since sometimes we find it in a file or on the internet), dates we've sent out license requests, dates we've received responses, dates we've sent out follow ups to people who never responded, dates licenses were received or denied, dates when we've decided that the museum holds the copyright or the work is suspected/declared orphaned. The status list you will use for each update is listed below to give you an idea of what you should record. Items beginning with the number "1" represent the research phase, "3" requests, "4" follow ups, "8" suspected orphans, "9" final statuses.

<table>
<thead>
<tr>
<th>Status Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Research: outstanding</td>
</tr>
<tr>
<td>11</td>
<td>Research: information request sent</td>
</tr>
<tr>
<td>12</td>
<td>Research: contact will forward letter</td>
</tr>
<tr>
<td>13</td>
<td>Research: direct contact obtained</td>
</tr>
<tr>
<td>31</td>
<td>License Request: sent</td>
</tr>
<tr>
<td>41</td>
<td>Response: received (excluding signed license)</td>
</tr>
<tr>
<td>42</td>
<td>Follow-up: sent</td>
</tr>
<tr>
<td>81</td>
<td>Suspected Orphan</td>
</tr>
<tr>
<td>90</td>
<td>BMA claims copyright</td>
</tr>
<tr>
<td>91</td>
<td>License: received</td>
</tr>
<tr>
<td>92</td>
<td>License: received with restrictions</td>
</tr>
<tr>
<td>93</td>
<td>License: denied but Open Collection allowed</td>
</tr>
<tr>
<td>94</td>
<td>License: denied</td>
</tr>
<tr>
<td>95</td>
<td>ARS</td>
</tr>
<tr>
<td>96</td>
<td>ARS</td>
</tr>
<tr>
<td>97</td>
<td>VAGA</td>
</tr>
<tr>
<td>99</td>
<td>Orphaned</td>
</tr>
</tbody>
</table>
a. Use the "Add or View Updates by Artist – Form":

- Select the artist from the "Maker / Culture" drop down box (they're sorted by first name). You can also start typing the artist's name and the drop down box will bring you to that letter.

- If the artist is not listed, close the form and, as noted in point 1 above, open the "Artists" table and add the artist. Then reopen the "Add or View Updates by Artist – Form" and select the artist from the "Maker / Culture" drop down box.

- Add an update record for the artist. (You will be selecting the contact from the dropdown box, just as you did for the artist. If the contact is not listed, you must follow the process for 2b above, except that you will update the "Contacts" table.)

BMA Staff, Method and Status are also choices you must make from dropdown boxes.
d. Use both scrollbars at the bottom of the screen to make sure you fill out the entire update. The last four columns are checkboxes/checklists for license requests sent out via mail and signed licenses received.

3. You can also use the "Add or View All Updates – Table" query to add information in a table form, but it can be harder to read and doesn’t explain anything:

4. Several reports are available which allow you to see the department’s progress:
The reports can be used to review how much work we've accomplished so far, or to see which artists might need follow up, or to see artists still needing research, etc.

a. The first report, "View Current Status by Artist," allows you to look at a table of only the last updates for each artist (note that in cases where two updates are entered for the same day for the same artist, both updates will appear). The table is sorted by artist last name:

b. The next three reports are for printing:

i. "Report on Current Status by Artist" is basically the same as the "View Current Status by Artist" report, but is formatted for printing.
ii. "Report on Current Status by Status" shows the same information as 4.b.i., but is sorted by status (but again, note that in cases where two updates are entered for the same day for the same artist, both updates will appear, meaning the subtotals may have to be adjusted). This is helpful to find artists needing more work done.

iii. "Report on All Updates by Artist" is similar to the "Add or View All Updates – Table" entry form described in number 3 above, and can be used to show the entire process we’ve followed for each artist (especially useful if/when we want to declare works orphaned):

Statistics may need to be adjusted.

---

c. The final report, "WATCH File To Be Sent," is a query which generates a list of confirmed artist contact information to be sent to the online WATCH File at http://tyler.hrc.utexas.edu/. The WATCH File is a shared database of artist contact information which is jointly maintained by the University of Texas at Austin and the University of Reading. The "WATCH File To Be Sent" query looks at the current status of artists and finds those with (i) statuses of licenses received/denied or statuses of sent follow-ups (statuses beginning with "9" or statuses equal to "42"), (ii) contacts with blank "WATCH Sent" fields (information not sent yet).

i. Open the WATCH File To Be Sent query, which searches for artists with latest statuses beginning with "9" ("final" statuses) or are "42" (follow-ups sent),
whose contact information hasn’t yet been sent to the WATCH File

ii. On the top menu, click on "External Data," then the "Excel" link in the "Export" section
iii. On the Export – Excel Spreadsheet screen:
   - Save the file as \\darjeeling\digitallab\PROJECTS\copyright\working files\[your name]'s work\WATCH Update [yy-mm-dd]
   - Specify file format of Excel 97 – Excel 2003 Workbook (*.xls)
   - Check off the boxes for "Export data with formatting and layout" and "Open the destination file after the export operation is complete"

iv. Email the Excel file to Deb to be forwarded to the WATCH File email contact. Select the first two columns and print them out

v. After Deb forwards the file, if she has not already done so, open the Artists table and add the WATCH Sent date for each artist on the list you just printed

5. The "Reference" area of the database contains the lists of BMA staff members, contact methods, and status types. These may occasionally need updating (particularly the list of BMA staff working on copyright clearance):
a. "Methods" as of May 21, 2009 are: archives (Brooklyn Museum archives), e-mail, fax, internet, on file (TMS/curatorial/Digital Lab files), phone, post

b. "Status" types as of May 21, 2009 are:

<table>
<thead>
<tr>
<th>Method</th>
<th>Status Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 - Research: outstanding</td>
<td>90 - BMA claims copyright</td>
</tr>
<tr>
<td>11 - Research: information request sent</td>
<td>91 - License: received</td>
</tr>
<tr>
<td>12 - Research: contact will forward letter</td>
<td>92 - License: received with restrictions</td>
</tr>
<tr>
<td>13 - Research: direct contact obtained</td>
<td>93 - License: denied but Open Collection allowed</td>
</tr>
<tr>
<td>31 - License Request: sent</td>
<td>94 - License: denied</td>
</tr>
<tr>
<td>41 - Response: received (excluding signed</td>
<td>96 - ARS</td>
</tr>
<tr>
<td>license)</td>
<td></td>
</tr>
<tr>
<td>42 - Follow-up sent</td>
<td>97 - VAGA</td>
</tr>
<tr>
<td>81 - Suspected Orphan</td>
<td>99 – Orphaned</td>
</tr>
</tbody>
</table>

6. The "Database Management" area of the database contains various database elements which are necessary to run the database and should not be edited. "Unassigned Objects" is for temporary queries.
1. Basic searching for artworks by a particular artist
   
a. From the main TMS screen, click on Objects
b. On the Objects Query screen, choose "Find Object" and click Next:
   
c. In the Find Object window, click the ellipsis next to "Constituent":

![Diagram of TMS interface for searching artworks by artist]
d. In the "Constituent Assistant" window, type the last name in the Last Name field, select the artist from the box on the right, and click "Select".

e. Back in the "Find Object" window, you'll see the artist's name in the "Constituent" field; click "Find" to execute the search.
2. Reviewing your results

a. Note that the basic search finds all works associated with an artist, which may include works donated by an artist as well as works which may not actually need clearance, so you always need to review the results of the search:

b. The quickest way to determine which of the works found in the search will need to be cleared is to run a Copyright Status Report:

   i. From any object screen go to Reports > Copyright Status
ii. When prompted by the Report Viewer, click on "Display Report"

iii. On the report, find all objects with "ObjRightsType" equal to either blank, under copyright: 1923-77, or under copyright: 1978-present (see Appendix note 3 to see what fields were used to determine these original ObjRightsType values)

iv. Note the object numbers (you may want to print the report)

3. Build an object package by adding individual objects (see 4 below if you have a lot of objects)

As shown above, any search may yield results which you don’t want to include in a license. You should create what’s called an "Object Package" to save the set of results that you actually want to work on.
a. From your search results, click on Tools > Show Object Package

b. When you want to add a work to the Object Package, click on "Add"

c. Click on "OK" to add the object

d. Continue paging through the objects using the arrows on the top right of the screen and adding objects you want to the package by clicking on "Add" and then "OK" as described above. Note that you can move the Object Package box around as

83
needed to view the screen
When you have finished reviewing all of the objects, save the Object Package:

i. Expand the Object Package by clicking on the arrow at the bottom right. Make sure you are on the "Package Info" tab:

ii. Check off the "Global" field, which makes this package viewable by other staff. Then click on "Save," name the file "DL [Last][First]," and click "OK"
iii. Click "Execute" and note how the original search results have been narrowed down by your object package.
4. Building an object package by adding everything from your search and then subtracting individual items

If your search results are large, you could also consider building the object package by adding everything you’ve found from your search and then subtracting one by one. You will still have to review every object, but you will cut down on the number of clicks necessary

a. From your search results, click on Tools > Show Object Package

b. Add all items from your search at once to the object package by clicking on "Clear" to clear anything already on the list, then "Make"

c. Answer "yes" when asked if you want to add all items from your search to the package:
d. Move the Object Package box to the right side of the screen. Page through the objects using the arrows at the top right. When you find an object that needs removing (in the example below, the work was created before 1923), find and highlight the corresponding object number in your object package.

e. Expand the object package box by clicking the arrow on the bottom right. Then select the "Object Info" tab and click "Remove Object" to remove the object from
f. You can leave the object package box expanded as you check each remaining item and just move the box as needed to see parts of the screen. **Always remember to check the object number before removing it from the package.**

g. When you have finished reviewing all of the objects, save the Object Package:
   i. Click on the "Package Info" tab to select it:
ii. Check off the "Global" field, which makes this package viewable by other staff. Then click on "Save," name the file "DL [Last][First]," and click "OK"

![Image of object package setup]

iii. Click "Execute" and note how the original search results have been narrowed down by your object package

![Image of search results narrowing down]

5. Reload an object package

Now that you have created an object package, you can continue to add to it if for some reason there are other works you find that need to be added, or reload it later if needed:

a. From any objects page, click on Tools > Show Object Package

![Image of tools section with Show Object Package highlighted]
b. Select the object package name from the dropdown list and click on "Execute"

![Object Package dropdown list]

- Save  Save As  Execute
- Add  Clear  New
- DL ArtilesGallardo
- DL BrookesGaraide
- DL FlahertyLiving
- DL Maps
- DL MooreJohnL
- DL NationRobert
- DL OConnellDennis
- DL PichardJudyline

- Reposition Object 8 entries

- Close the object package mini-window by clicking on the red "x" in the upper right corner

6. **Advanced searches Using Advanced Query**

If you are comfortable working in TMS and in creating Boolean searches, you may want to use the Advanced Query function to build a query. For the most part, you shouldn't need to, however.

a. From the main TMS screen, click on "Objects," then "Advanced Query," then "Next"

![Objects Query window]

- Query  Query Assistant  Advanced Query
- First Object  Select Random Entry  Object Number

- Display Node  Label Copy  Data Entry
- Light Box  List in Web Images  List
- Hierarchy  Getts
def

- Click Next when you are ready to continue

b. One useful query is shown below. This query searches for a particular artist's name and works created 1923 or later, works with a blank date, or works with words in the date which you will have to check manually one by one. Note the use of "And" and "Or" on the left and the use of parentheses (all selected from dropdown boxes)
This query is equivalent to:

Last Name="Hopper" AND First Name="Edward" AND (Date ≥ 1923 OR Date < 1 OR Date ≥ a)

Note: "Date < 1" will capture blank dates and "Date ≥ a" will capture dates with text ("n.d.", "not dated," "ca." etc.)

Also potentially useful in searches is the "Object Rights Type" field under "Rights and Reproductions"

d. Note, however, that searching on Current Location (for "Out of BMA") is complicated and is not recommended

7. Basic searching for artists for contact information

Sometimes we already have contact information for artists/rightsholders. From the main TMS screen, click on "Constituents" and perform a basic search for the artist – it
operates the same way as basic searches for objects. Note that this contact information can still be out of date, however, so don't rely completely on it.

8. Editing copyright status

When you get a signed license or occasionally under other circumstances, you will need to edit the copyright status in TMS. Find the object(s) you need to work on (here’s where the Object Package can come in handy)

a. For each object needing editing, on that object's screen click on "Registration," then "Rights and Reproductions"

b. In the Rights and Reproductions window, select the correct Object Rights Type (in the example it's "copyright cleared: license on file with restrictions"), and change the Copyright line to match the license and summarize any restrictions under the © sign is created by holding down the <Alt> key while typing 0169 on the number pad.
9. TMS reports you will use

There is a long list of reports you can generate on the set of objects you have loaded via a search or an object package. The reports you will need most often are:

a. To generate a license, from the objects screen go to Registration > Accessioning, then Report > Non-Exclusive License (see instructions for generating a license)
b. To generate a license cover letter, from the objects screen go to Report > Object List-Legal Paper (see instructions for generating a license)
c. To get a summary of copyright status, from the objects screen go to Report > Copyright Status. This is a newly designed report as of May 18, 2009 which is useful to check that the correct copyright status has been recorded in TMS for all objects in an object package
Identifying and Locating Rightsholders

1. Make sure the artist is not represented by the Artist Rights Society (ARS, www.arsny.com) or the Visual Artists and Galleries Association (VAGA, www.vaga.org):
   a. Consult the complete online list of ARS artists at http://www.arsny.com/complete.html
   b. Consult the Digital Lab’s latest downloaded list of VAGA artists: My Documents\PROJECTS\copyright\reference\ARTISTS-VAGA+SOCIETIES 10-31-08 (CARCC added).xls
     (or more current version of file)

2. When you are just beginning to work on the project, a good list of sources to begin your search is the orphan works checklist (which you would have to complete anyway when we have decided to try to declare a work orphaned):
   My Documents\PROJECTS\copyright\reference\orphaned_works_checklist.doc

As of May 26, 2009, the orphaned works checklist suggests the following resources to check for information. Remember you must identify both the rightsholder for the artists’ works and contact information for the rightsholder

**Online Resources**
- [http://tyler.hrc.utexas.edu/](http://tyler.hrc.utexas.edu/) University of Texas at Austin “WATCH” file (Writers, Artists, and Their Copyright Holders”
- [http://www.loc.gov/rr/print/res/rights.html](http://www.loc.gov/rr/print/res/rights.html) Library of Congress, Prints Drawings and Photographs pages include information about copyright status
- [www.google.com](http://www.google.com) check all directories because they may not have the same results
- Online phone and address directories
  - [www.superpages.com](http://www.superpages.com)
  - [www.411.com](http://www.411.com)
  - [www.switchboard.com](http://www.switchboard.com)
- [www.peoplesearch.com](http://www.peoplesearch.com)
- [www.askart.com](http://www.askart.com) Artist bio, collection, and auction info
- [www.artnet.com](http://www.artnet.com) Artist bio, collection, and auction info
- Wikipedia Sometimes has reliable/useful information
- Newspaper databases for obits or other mentions
- Gallery websites For biographical information and see below
- MusIP Yahoo! museum intellectual property group, at http://groups.yahoo.com/group/musip/. Join this listserv, check previous posts, and post when you've reached a dead end (or answer other people’s posts!)

**DRAWINGS STUDY CENTER, MoMA**
A good source for research…I wrote to them and they know a lot of addresses of artists. Works may be viewed, and files on each work are available for consultation. Located at 11 W 53 St in midtown Manhattan and 45-20 33 St in Long Island City, Queens. By appointment Wednesday, Thursday, and Friday, 11:00 a.m.–5:00 p.m. e-mail dsc@moma.org.

**In-house Resources**
- TMS For birth/death dates and sometimes artist contact info which, though possibly out of date, may help locate the artist
- Curatorial files Occasionally have useful information, and are a good place to check
out any previous correspondence we may have had, especially for contemporary artists

- Artist files in the BM library
- Library ephemera collection, frequently includes clippings

**Research Avenues**

- **Publications**
  - Search image credit lines for estate or representative’s names, e.g. “Gift of the artist’s wife, XYZ”

- **Museums**
  - Contact museums with large holdings of the artist: possibly they were given the estate

- **Curators/museums/registrars**
  - Contact people/institutions that have done shows on the artist, especially if a catalog was published. Note that registrars often have confidential contact information and will forward a letter.

- **Galleries**
  - Look for galleries which say explicitly they are representatives of artist or estate

- **Scholars**
  - Contact scholars who have written monographs/journal articles on the artist. Searching Amazon and JSTOR are good ways to start this—once you find a name, typically you can find their e-mail address from where they teach

- **Collections databases**
  - If available, check provenance records in collections databases: sometimes they mention by name the representative of the estate.

- **Auction databases**
  - To potentially track info on a seller who may have more information.

- **Archives**
  - If an institution holds the papers of an artist or family, they may have contact information.

3. If you *think* you’ve found the correct contact information, it is usually worthwhile to send a feeler letter/email asking if they are/represent the rightsholder (this would be recorded in the Access database as "11 - Research: information request sent").

4. Note that if you contact a gallery it is worth checking to see if any other artists whom gallery represents are included in our collection and to contact the gallery regarding all of those artists at once. Sometimes phone calls work better with galleries than emails or posted letters.
1. Construct an Object Package in TMS for the artist's works needing a license, following the guidelines above. Recommended naming scheme for the Object Package is "DL [Lastname][Firstname]" i.e. "DL HopperEdward"

2. Create the TMS version of the nonexclusive license agreement:
   a. Go to Registration > Accessioning
   b. From the Accessioning screen, go to Report > Non-Exclusive License
   c. Click on the Export Report icon in the upper left ( ) and select "Microsoft Word - Editable (RTF)" (make sure you choose editable), and then OK
   d. Click OK again to export all pages of the license
e. Save the file to My Documents\PROJECTS\copyright\working files\[your name]'s work\[LastFirst]. Type should be RTF.

f. Close the Accessioning screen, but do not exit the Objects screen with your current Object Package

3. Create the data for the cover letter:
   a. From the Objects screen, go to Report > Copyright Object Info
b. Click on "Display Report"

c. Click on the Export Report icon in the upper left ( ) and select "Microsoft Word – Editable (RTF)", and then OK

d. Click OK to accept the default settings for the export

e. Save the file to My Documents\PROJECTS\copyright\working files\[your name]'s work\[Last][First] LTR. Type should be "Rich Text Format (*.rtf)"
f. Close the Object List-legal paper screen and close the Objects screen

4. Generate the nonexclusive license agreement:
   a. In Word, click on the Word icon in the upper left ( ) and click on New
   
   ![Word interface showing new document creation]

   b. Click on My Templates and select "Non-Exclusive License Letterhead"

   ![My Templates interface showing the selection of a template]

   c. Click on OK
   d. In Word, open the RTF file you created in step 2
   e. Clean up the RTF file:
      i. Remove the extra tabs: replace "^t" (no quotes) with nothing for the whole document

   ![Find and Replace dialog box with leave option selected]
ii. Remove the extra paragraph marks: replace "^p" (<space>^p, with no quotes) with " " (<space>) for the whole document

iii. Go through document to make sure you have removed all extra paragraph marks and tabs, and to make sure paragraphs wrap correctly

iv. Select the entire document by holding down <Ctrl> and pressing 5 on the numpad.

v. On the Home menu tab, click on the down arrow in the Paragraph area and change the line spacing for the whole document to "Single," then press "OK"

vi. Fix the two numbered paragraphs in the license agreement by putting tabs after the parentheses.

1) in educational materials related to the Museum’s collection and programs (including, for example, posters, postcards, teaching materials, web sites, social networks, catalogues and similar publications, some of which may be offered through Museum’s stores); and
2) in publicity and informational materials about the Museum’s collection and programs (including, for example, press releases, web sites, social networks, annual reports, promotional flyers, email, posters or films, and membership solicitations).
vii. Select the paragraphs and click on the down arrow in the Paragraph area and change the Indentation to Special > Hanging. By > 0.25"

f. If the list of works in the RTF file ends on page 1:
   i. In the RTF file, select the text from the beginning up to and including the copyright line ("© Artist / Estate of the Artist"). Do not worry about the header or footer. Click on Edit > Copy

   From here

   NON-EXCLUSIVE LICENSE
   FOR COPYRIGHT
   Artist: Georgia O'Keeffe
   Title: Year: 1919–20
   Medium: Acrylic on canvas
   Dimensions: Object Number: 71.316-1

   From here

   To here
ii. Go to the new document you created in step 4c
iii. Highlight the text "[Please see attached pages for complete list of artworks.]
    and Edit > Paste
iv. Position the cursor just below the Date line at the bottom of the signature area and <Delete> the page break and the following paragraphs ("Complete List of Artworks")
v. Go to step 4h below
g. If the list of works extends beyond page 1, you will be placing the list of works at the end of the final license rather than at the beginning, so you need to copy and paste twice (once for the license text and once for the list of artworks):
i. In the RTF file, select the license text from the beginning of the license language (right after the list of artworks) up to and including the copyright line ("© Artist / Estate of the Artist"). Do not worry about the header or footer.

From here
ii. Go to the new document you created in step 4c

iii. Position the cursor just below "[Please see attached pages for complete list of artworks.]" and Edit > Paste

iv. Delete the brackets around "Please see attached pages for complete list of artworks"

v. Go back to the RTF file and select the list of artworks
vi. Switch to the new license document, go to the end by holding down <Ctrl> and pressing <End>, and Edit > Paste

vii. Go to step 4h below

h. Continue cleaning up the license agreement (for both types of licenses outlined in f and g above):
   i. Edit the copyright line so it reflects the copyright holder’s name (usually *either* the artist’s name *or* "Estate of" the artist, not both)

   Choose one and delete the

   Estate of Edward Hopper

   ii. Position the cursor just below the copyright line and <Delete> the page break.

x. Save the license using the filename and format My Documents\PROJECTS\copyright\license and correspondence\[LastFirst] License.doc

xv. Close the RTF file, which you will no longer need
5. Generate the cover letter:
   a. In Microsoft Word, open the RTF file you created in step 3 ([Last][First] LTR.rtf)
   b. Clean up the RTF file:
      i. Remove the extra tabs: replace "^t" (no quotes) with nothing for the whole document
      ii. Select all of the works in the list:
      iii. Change the font to Brooklynesque
      iv. Keeping the list selected, change the paragraph formatting so that the paragraph is 0.5" indented on left with a hanging indent of 0.5" and single line
c. Keeping the RTF file open, click on the Word icon in the upper left ( ) and click on New

d. Click on My Templates and select the cover letter type which suits your request (note that in cases where you have to contact living artists’ representatives you will need to generate still another cover letter):

i. Letter_Artist_DIRECT_EMAIL

ii. Letter_Artist_DIRECT_POST

iii. Letter_ESTATE

iv. Letter_OPENCOLLECTION_Artist_DIRECT_POST (almost never used)

e. Click on OK

f. To automatically generate an address block from the database to copy into the letter:
i. Open the CopyrightResearch database in Access, right click on the Query for Address Block, and select Design View:

ii. In the column for the Contact field, change the "Like" criteria to match your contact. Use quotation marks to enclose the name and use the asterisk (*) for wildcard searching. Then click on the big red exclamation point labeled "Run" to run the query:
iii. Verify that you have the correct contact selected, then close the query, **making sure you answer "Yes" to save changes to the query design**.

iv. Open the Address Block for Letters report and copy whatever address lines you need into your letter. You will have to copy line by line (you may also export the address, but this is more trouble than it's really worth).

g. Edit the addressee information as needed, using the address block you just generated (**don't worry about the date line yet**):

   - **Date** (will be automatically updated)
   - Name and address from step f above
   - **Salutation**

i. For letters that will be mailed, enter the name and full address from step f above
ii. For letters that will be emailed, enter the name and email address in angled brackets (<johnsmith@johnsmith.com>) from step f above

h. Edit the salutation line, using formal address (i.e. "Mr. Lastname")

i. Replace [Artist] with the artist’s name if necessary, and edit any instances of "[him/her]"

j. Select the entire line that reads [INSERT OBJECTS HERE], not including the paragraph mark:

<table>
<thead>
<tr>
<th>Copyright Object Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Manhattan Roof, 1923, Museum Collection Fund, 25, 100</td>
</tr>
<tr>
<td>Macomb's Dam Bridge, 1935, Bequest of Mary T. Cockcroft, 57, 145</td>
</tr>
<tr>
<td>East Side Interior, Dick S. Ramsey Fund, 58, 48</td>
</tr>
<tr>
<td>Maple Coast, 1923, Dick S. Ramsey Fund, 58, 189</td>
</tr>
<tr>
<td>House at Riverdale, 1928, Bequest of Anita Stackler, 2003, 1</td>
</tr>
<tr>
<td>Manhattan Bridge Loop, 1926, EL66, 49</td>
</tr>
<tr>
<td>Lighthouse Hill, 1927, EL66, 49</td>
</tr>
<tr>
<td>Eleven A.M., 1926, EL66, 51</td>
</tr>
</tbody>
</table>

k. Go back to the RTF file you worked on in step 5b and select all of the works in the list:
l. Edit > Copy. Switch to the new letter and Edit > Paste:

```
<click here to type name>
<click here to type address>

Dear [Mr./Ms./[Artist LastName]],

The Brooklyn Museum is honored to have in its collection the following work(s) of art which you created:

- The Metropolitan, 1993, Museum Collection Fund: 23.110
- Maco's Bridge, 1993, Request of Mary T. Cockroft, 51.145
- East Side Interior, Dick S. Ramsay Fund: 58.49
- Anne Cogli, 1993, Dick S. Ramsay Fund, 58.199
- Manhattan Bridge Loop, 1992, EL66.49

We are currently going through a process to make sure our paperwork is complete and find that we do not have a non-exclusive license form on file for your works.

While ownership of a work of art gives the Museum the right to do a variety of things, it does not transfer copyright, which you retain. The non-exclusive license will grant us permission to use images of your work for Museum-related activities.

We look forward to receiving the signed document at your earliest convenience. Arlene Yu, our project intern, or I would be happy to assist you if you have any questions. Please do not hesitate to contact us.

Sincerely and with many thanks,
```

m. Save the new letter using the filename and format

```
My Documents\PROJECTS\copyright\license and correspondence\[LastFirst] [Estate] Letter.doc
```

n. Close the letter and reopen it (this updates the dates automatically); if a "File In Use" message comes up, click on <Cancel> or press <Esc>
o. If applicable, create a "forwarding letter" in those cases where the contact has agreed to forward the license request on our behalf to the rightsholder. The forwarding letter templates are:
   i. Letter_Forwarding_Cover_No‐previous_Contact
   ii. Letter_Forwarding_Cover_Previous_Contact
p. For mailed letters, create an envelope and an SASE, if possible (for the SASE, just open and print the SASE.doc file in the templates folder). Don't forget to put a stamp on the SASE
q. For emailed letters:
   i. Create a new email message in Outlook, addressed to Deborah Wythe, subject line "Brooklyn Museum Copyright Project" (without the quotes)
   ii. Copy and paste the Word letter text into your email message, without the date
   iii. Attach Word versions of both the cover letter and the license agreement to the email message
   iv. Send the message
6. Record the license request generation
   a. Make/print a copy of the letter(s)/email and file it by artist last name in the copyright files
   b. Open the CopyrightResearch database in Access
b. Open the "Add or View Updates by Artist – Form" and select the artist from the "Maker / Culture" dropdown box.

d. Add an update record for the artist. (If the contact is not listed, you must follow the process for 6c above, except that you will update the "Contacts" table).
Remember to use both scrollbars at the bottom of the screen to fill out the entire update, and that license requests sent via post are usually sent with an SASE:
Following Up on Previous License Requests

Periodically you will want to check on outstanding requests.

1. Open the Access database and use "Report on Current Status by Status" to find artists with current status of:

   31 - License Request: sent
   41 - Response: received (excluding signed license)
   42 - Follow-up: sent

   where the last update is more than six months old

2. Generate follow-up letters using the follow-up templates (File > New > My templates > [template name])

   Follow-up_Letter_Artist
   Follow-up_Letter_Estate
   Follow-up_Letter_Forwarding PHONE GALLERY FIRST

   *Note: when the follow-up contact is a gallery, it is a good idea to call the gallery first*

3. Save the letter in \My Documents\PROJECTS\copyright\license and correspondence, using the format "[Last][First] FollowUp [Estate].doc" i.e. "HopperEdward FollowUp Estate.doc"

4. File a paper copy of the letter

5. Record the follow-up in the Access database (status would be "42 – Follow-up: sent")
Processing a Signed License

The Access database provides a good checklist for you to make sure you have completed all steps to processing a signed license.

1. Edit the copyright status ("Object Rights Type") in TMS
   
a. Find the object(s) you need to work on (here’s where having created an Object Package can come in handy).
   
b. For each object needing editing, on that object’s screen click on "Registration," then "Rights and Reproductions."

   b. In the Rights and Reproductions window, select the correct Object Rights Type, either "copyright cleared: license on file" or "copyright cleared: license on file with restrictions." Change the Copyright line to match the license and summarize any restrictions under Restrictions and Permissions.

   c. Click "OK"
d. Once you’ve completed steps b. and c. for all objects in your object package, from any object screen go to Reports > Copyright Status

e. When prompted by the Report Viewer, click on "Display Report"

f. Check the report to make sure you haven’t missed any objects

All objects have been changed
2. Make a paper copy of the license. File the original license in the originals file and the copy in the correspondence file; all filing is by artist last name to match TMS and the Access database.

3. Construct a thank you/acknowledgement using clear photo corners (ordered from Gaylord), two museum passes (if no expiration date, make sure you date them to expire in one year), and the thank you notecard (more copies of the thank you notecard can be printed from the document \My Documents\PROJECTS\copyright\templates\Thank_You_Card.doc)

4. Add an update to the Access database to record the license receipt, using status "91 – License: received" or "92 – License received with restrictions"
   a. Open the "Add or View Updates by Artist – Form"
   b. Select the artist from the "Maker / Culture" drop down box
c. Add an update record for the artist

Remember to use both scrollbars at the bottom of the screen to fill out the entire update, and to check off that you completed the three previous steps:

New update

Scrollbars

Sample license received record

Checklist

Scrollbars

d. Check the return address envelope for the received license, if you have it, to see if there is any additional contact information you can capture in the Access database. For example, you may have sent the license request via a gallery but received the license directly from the artist in an envelope which has the artist's mailing address. You should add the artist to the Contacts database and the update for "91 - License received" should give the artist as the contact.
Appendix

1. Supply sources

   Stamps  Finance Department (6th Floor) – bring petty cash voucher
   Envelopes  Print Shop (basement)
   Thank you card blanks  Development Department (6th Floor) – see John Carini and ask for "logo cards"
   Guest passes  Marketing and Visitor Services (1st Floor)
   Photo corners (for thank you cards)  Gaylord SKU# 20516150 (ordered by Deb Wythe)

2. Access database design
3. The original Object Rights Type values have been set by examining the following fields to determine if the object will need to be cleared:

- **EXCLUDE:** created before 1923 (but dates which are blank, "n.d.", or "not dated" should)
- **EXCLUDE:** 3D works (sculptures, furniture, clothing)
- **EXCLUDE:** "Out of BMA" either "DEACCESSIONED" or "RETURNED TO LENDER" (but not just)
- **INCLUDE:** created 1923 or later, blank date, "n.d.", "not dated"
- **INCLUDE:** 2D works,
- **INCLUDE:** Any location other than "Out of BMA" and work is NOT "DEACCESSIONED" or "RETURNED TO LENDER,"
Appendix I: Creative Commons Attribution-NonCommercial License

CREATIVE COMMONS CORPORATION IS NOT A LAW FIRM AND DOES NOT PROVIDE LEGAL SERVICES. DISTRIBUTION OF THIS LICENSE DOES NOT CREATE AN ATTORNEY-CLIENT RELATIONSHIP. CREATIVE COMMONS PROVIDES THIS INFORMATION ON AN "AS-IS" BASIS. CREATIVE COMMONS MAKES NO WARRANTIES REGARDING THE INFORMATION PROVIDED, AND DISCLAIMS LIABILITY FOR DAMAGES RESULTING FROM ITS USE.

License

THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS CREATIVE COMMONS PUBLIC LICENSE ("CCPL" OR "LICENSE"). THE WORK IS PROTECTED BY COPYRIGHT AND/OR OTHER APPLICABLE LAW. ANY USE OF THE WORK OTHER THAN AS AUTHORIZED UNDER THIS LICENSE OR COPYRIGHT LAW IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU ACCEPT AND AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE. TO THE EXTENT THIS LICENSE MAY BE CONSIDERED TO BE A CONTRACT, THE LICENSOR GRANTS YOU THE RIGHTS CONTAINED HERE IN CONSIDERATION OF YOUR ACCEPTANCE OF SUCH TERMS AND CONDITIONS.

1. Definitions

a. "Adaptation" means a work based upon the Work, or upon the Work and other pre-existing works, such as a translation, adaptation, derivative work, arrangement of music or other alterations of a literary or artistic work, or phonogram or performance and includes cinematographic adaptations or any other form in which the Work may be recast, transformed, or adapted including in any form recognizably derived from the original, except that a work that constitutes a Collection will not be considered an Adaptation for the purpose of this License. For the avoidance of doubt, where the Work is a musical work, performance or phonogram, the synchronization of the Work in timed-relation with a moving image ("synching") will be considered an Adaptation for the purpose of this License.

b. "Collection" means a collection of literary or artistic works, such as encyclopedias and anthologies, or performances, phonograms or broadcasts, or other works or subject matter other than works listed in Section 1(f) below, which, by reason of the selection and arrangement of their contents, constitute intellectual creations, in which the Work is included in its entirety in unmodified form along with one or more other contributions, each constituting separate and independent works in themselves, which together are assembled into a collective whole. A work that constitutes a Collection will not be considered an Adaptation (as defined above) for the purposes of this License.
c. "Distribute" means to make available to the public the original and copies of the Work or Adaptation, as appropriate, through sale or other transfer of ownership.

d. "Licensor" means the individual, individuals, entity or entities that offer(s) the Work under the terms of this License.

e. "Original Author" means, in the case of a literary or artistic work, the individual, individuals, entity or entities who created the Work or if no individual or entity can be identified, the publisher; and in addition (i) in the case of a performance the actors, singers, musicians, dancers, and other persons who act, sing, deliver, declaim, play in, interpret or otherwise perform literary or artistic works or expressions of folklore; (ii) in the case of a phonogram the producer being the person or legal entity who first fixes the sounds of a performance or other sounds; and, (iii) in the case of broadcasts, the organization that transmits the broadcast.

f. "Work" means the literary and/or artistic work offered under the terms of this License including without limitation any production in the literary, scientific and artistic domain, whatever may be the mode or form of its expression including digital form, such as a book, pamphlet and other writing; a lecture, address, sermon or other work of the same nature; a dramatic or dramatico-musical work; a choreographic work or entertainment in dumb show; a musical composition with or without words; a cinematographic work to which are assimilated works expressed by a process analogous to cinematography; a work of drawing, painting, architecture, sculpture, engraving or lithography; a photographic work to which are assimilated works expressed by a process analogous to photography; a work of applied art; an illustration, map, plan, sketch or three-dimensional work relative to geography, topography, architecture or science; a performance; a broadcast; a phonogram; a compilation of data to the extent it is protected as a copyrightable work; or a work performed by a variety or circus performer to the extent it is not otherwise considered a literary or artistic work.

g. "You" means an individual or entity exercising rights under this License who has not previously violated the terms of this License with respect to the Work, or who has received express permission from the Licensor to exercise rights under this License despite a previous violation.

h. "Publicly Perform" means to perform public recitations of the Work and to communicate to the public those public recitations, by any means or process, including by wire or wireless means or public digital performances; to make available to the public Works in such a way that members of the public may access these Works from a place and at a place individually chosen by them; to perform the Work to the public by any means or process and the communication to the public of the performances of the Work, including by public digital performance; to broadcast and rebroadcast the Work by any means including signs, sounds or images.

i. "Reproduce" means to make copies of the Work by any means including without limitation by sound or visual recordings and the right of fixation and reproducing fixations of the Work, including storage of a protected performance or phonogram in digital form or other electronic medium.
2. Fair Dealing Rights. Nothing in this License is intended to reduce, limit, or restrict any uses free from copyright or rights arising from limitations or exceptions that are provided for in connection with the copyright protection under copyright law or other applicable laws.

3. License Grant. Subject to the terms and conditions of this License, Licensor hereby grants You a worldwide, royalty-free, non-exclusive, perpetual (for the duration of the applicable copyright) license to exercise the rights in the Work as stated below:

a. to Reproduce the Work, to incorporate the Work into one or more Collections, and to Reproduce the Work as incorporated in the Collections;
b. to create and Reproduce Adaptations provided that any such Adaptation, including any translation in any medium, takes reasonable steps to clearly label, demarcate or otherwise identify that changes were made to the original Work. For example, a translation could be marked "The original work was translated from English to Spanish," or a modification could indicate "The original work has been modified."

c. to Distribute and Publicly Perform the Work including as incorporated in Collections; and,
d. to Distribute and Publicly Perform Adaptations.

The above rights may be exercised in all media and formats whether now known or hereafter devised. The above rights include the right to make such modifications as are technically necessary to exercise the rights in other media and formats. Subject to Section 8(f), all rights not expressly granted by Licensor are hereby reserved, including but not limited to the rights set forth in Section 4(d).

4. Restrictions. The license granted in Section 3 above is expressly made subject to and limited by the following restrictions:

a. You may Distribute or Publicly Perform the Work only under the terms of this License. You must include a copy of, or the Uniform Resource Identifier (URI) for, this License with every copy of the Work You Distribute or Publicly Perform. You may not offer or impose any terms on the Work that restrict the terms of this License or the ability of the recipient of the Work to exercise the rights granted to that recipient under the terms of the License. You may not sublicense the Work. You must keep intact all notices that refer to this License and to the disclaimer of warranties with every copy of the Work You Distribute or Publicly Perform. When You Distribute or Publicly Perform the Work, You may not impose any effective technological measures on the Work that restrict the ability of a recipient of the Work from You to exercise the rights granted to that recipient under the terms of the License. This Section 4(a) applies to the Work as incorporated in a Collection, but this does not require the Collection apart from the Work itself to be made subject to the terms of this License. If You create a Collection, upon notice from any Licensor You must, to the extent practicable, remove from the Collection any credit as required by Section 4(c), as requested. If You create an Adaptation, upon notice from any Licensor You must, to the extent practicable, remove from the Adaptation any credit as required by Section 4(c), as requested.
b. You may not exercise any of the rights granted to You in Section 3 above in any manner that is primarily intended for or directed toward commercial advantage or private monetary compensation. The exchange of the Work for other copyrighted works by means of digital file-sharing or otherwise shall not be considered to be intended for or directed toward commercial advantage or private monetary compensation, provided there is no payment of any monetary compensation in connection with the exchange of copyrighted works.

c. If You Distribute, or Publicly Perform the Work or any Adaptations or Collections, You must, unless a request has been made pursuant to Section 4(a), keep intact all copyright notices for the Work and provide, reasonable to the medium or means You are utilizing: (i) the name of the Original Author (or pseudonym, if applicable) if supplied, and/or if the Original Author and/or Licensor designate another party or parties (e.g., a sponsor institute, publishing entity, journal) for attribution ("Attribution Parties") in Licensor’s copyright notice, terms of service or by other reasonable means, the name of such party or parties; (ii) the title of the Work if supplied; (iii) to the extent reasonably practicable, the URI, if any, that Licensor specifies to be associated with the Work, unless such URI does not refer to the copyright notice or licensing information for the Work; and, (iv) consistent with Section 3(b), in the case of an Adaptation, a credit identifying the use of the Work in the Adaptation (e.g., "French translation of the Work by Original Author," or "Screenplay based on original Work by Original Author"). The credit required by this Section 4(c) may be implemented in any reasonable manner; provided, however, that in the case of a Adaptation or Collection, at a minimum such credit will appear, if a credit for all contributing authors of the Adaptation or Collection appears, then as part of these credits and in a manner at least as prominent as the credits for the other contributing authors. For the avoidance of doubt, You may only use the credit required by this Section for the purpose of attribution in the manner set out above and, by exercising Your rights under this License, You may not implicitly or explicitly assert or imply any connection with, sponsorship or endorsement by the Original Author, Licensor and/or Attribution Parties, as appropriate, of You or Your use of the Work, without the separate, express prior written permission of the Original Author, Licensor and/or Attribution Parties.

d. For the avoidance of doubt:

i. **Non-waivable Compulsory License Schemes.** In those jurisdictions in which the right to collect royalties through any statutory or compulsory licensing scheme cannot be waived, the Licensor reserves the exclusive right to collect such royalties for any exercise by You of the rights granted under this License;

ii. **Waivable Compulsory License Schemes.** In those jurisdictions in which the right to collect royalties through any statutory or compulsory licensing scheme can be waived, the Licensor reserves the exclusive right to collect such royalties for any exercise by You of the rights granted under this License if Your exercise of such rights is for a purpose or use which is otherwise than noncommercial as permitted under Section 4(b) and otherwise waives the right to collect royalties through any statutory or compulsory licensing scheme; and,
iii. **Voluntary License Schemes.** The Licensor reserves the right to collect royalties, whether individually or, in the event that the Licensor is a member of a collecting society that administers voluntary licensing schemes, via that society, from any exercise by You of the rights granted under this License that is for a purpose or use which is otherwise than noncommercial as permitted under Section 4(c).

e. Except as otherwise agreed in writing by the Licensor or as may be otherwise permitted by applicable law, if You Reproduce, Distribute or Publicly Perform the Work either by itself or as part of any Adaptations or Collections, You must not distort, mutilate, modify or take other derogatory action in relation to the Work which would be prejudicial to the Original Author’s honor or reputation. Licensor agrees that in those jurisdictions (e.g. Japan), in which any exercise of the right granted in Section 3(b) of this License (the right to make Adaptations) would be deemed to be a distortion, mutilation, modification or other derogatory action prejudicial to the Original Author’s honor and reputation, the Licensor will waive or not assert, as appropriate, this Section, to the fullest extent permitted by the applicable national law, to enable You to reasonably exercise Your right under Section 3(b) of this License (right to make Adaptations) but not otherwise.

5. **Representations, Warranties and Disclaimer**

UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN WRITING, LICENSOR OFFERS THE WORK AS-IS AND MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND CONCERNING THE WORK, EXPRESS, IMPLIED, STATUTORY OR OTHERWISE, INCLUDING, WITHOUT LIMITATION, WARRANTIES OF TITLE, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER DEFECTS, ACCURACY, OR THE PRESENCE OF ABSENCE OF ERRORS, WHETHER OR NOT DISCOVERABLE. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO SUCH EXCLUSION MAY NOT APPLY TO YOU.

6. **Limitation on Liability.** EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO YOU ON ANY LEGAL THEORY FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY DAMAGES ARISING OUT OF THIS LICENSE OR THE USE OF THE WORK, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

7. **Termination**

   a. This License and the rights granted hereunder will terminate automatically upon any breach by You of the terms of this License. Individuals or entities who have received Adaptations or Collections from You under this License, however, will not have their licenses terminated provided such individuals or entities remain in full compliance with those licenses. Sections 1, 2, 5, 6, 7, and 8 will survive any termination of this License.
b. Subject to the above terms and conditions, the license granted here is perpetual (for the duration of the applicable copyright in the Work). Notwithstanding the above, Licensor reserves the right to release the Work under different license terms or to stop distributing the Work at any time; provided, however that any such election will not serve to withdraw this License (or any other license that has been, or is required to be, granted under the terms of this License), and this License will continue in full force and effect unless terminated as stated above.

8. Miscellaneous

a. Each time You Distribute or Publicly Perform the Work or a Collection, the Licensor offers to the recipient a license to the Work on the same terms and conditions as the license granted to You under this License.
b. Each time You Distribute or Publicly Perform an Adaptation, Licensor offers to the recipient a license to the original Work on the same terms and conditions as the license granted to You under this License.
c. If any provision of this License is invalid or unenforceable under applicable law, it shall not affect the validity or enforceability of the remainder of the terms of this License, and without further action by the parties to this agreement, such provision shall be reformed to the minimum extent necessary to make such provision valid and enforceable.
d. No term or provision of this License shall be deemed waived and no breach consented to unless such waiver or consent shall be in writing and signed by the party to be charged with such waiver or consent.
e. This License constitutes the entire agreement between the parties with respect to the Work licensed here. There are no understandings, agreements or representations with respect to the Work not specified here. Licensor shall not be bound by any additional provisions that may appear in any communication from You. This License may not be modified without the mutual written agreement of the Licensor and You.
f. The rights granted under, and the subject matter referenced, in this License were drafted utilizing the terminology of the Berne Convention for the Protection of Literary and Artistic Works (as amended on September 28, 1979), the Rome Convention of 1961, the WIPO Copyright Treaty of 1996, the WIPO Performances and Phonograms Treaty of 1996 and the Universal Copyright Convention (as revised on July 24, 1971). These rights and subject matter take effect in the relevant jurisdiction in which the License terms are sought to be enforced according to the corresponding provisions of the implementation of those treaty provisions in the applicable national law. If the standard suite of rights granted under applicable copyright law includes additional rights not granted under this License, such additional rights are deemed to be included in the License; this License is not intended to restrict the license of any rights under applicable law.
Appendix J: Brooklyn Museum Image Fees

**DIGITAL IMAGES**

<table>
<thead>
<tr>
<th>Non-profit/Commercial</th>
<th>Non-profit/Commercial</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color digital tiff file for publication, 400 dpi</td>
<td>$90.00/$110.00</td>
</tr>
<tr>
<td>Black and white digital file from existing negative</td>
<td>$35.00/$70.00</td>
</tr>
</tbody>
</table>

New digital photography: 2-d object/3-d object: **$200.00/$250.00**

High resolution digital file for study/ non-publication use, **$45.00**

**USE FEES**

<table>
<thead>
<tr>
<th>Non-profit/Commercial</th>
<th>Non-profit/Commercial</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color reproduction, editorial</td>
<td>$55.00/$110.00</td>
</tr>
<tr>
<td>Color reproduction, decorative</td>
<td>$75.00/$150.00</td>
</tr>
<tr>
<td>Black and white reproduction, editorial</td>
<td>$35.00/$70.00</td>
</tr>
<tr>
<td>Black and white reproduction, decorative</td>
<td>$70.00/$150.00</td>
</tr>
</tbody>
</table>

**SPECIAL USES**

<table>
<thead>
<tr>
<th>Non-profit/Commercial</th>
<th>Non-profit/Commercial</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover reproduction (books, CD’s, etc.)</td>
<td>$350.00/$550.00</td>
</tr>
<tr>
<td>Calendars, posters, notecards, and other commercial products</td>
<td>$350.00/$550.00</td>
</tr>
<tr>
<td>Broadcast, video, &amp; dvd rights (rate for first image, discount for multiple images)</td>
<td>$175.00/$275.00</td>
</tr>
<tr>
<td>Brochures (interior)</td>
<td>$250.00/$450.00</td>
</tr>
</tbody>
</table>

Prices listed above are based on a distribution of 3,000 and may be higher according to distribution quantities. Other special uses considered upon request (i.e., location photography, advertising, multiple uses, bulk rates, custom-sized digital files)

**WORLD LANGUAGE RIGHTS PACKAGE** : All languages, unlimited print run

<table>
<thead>
<tr>
<th>Non-profit/Commercial</th>
<th>Non-profit/Commercial</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color reproductions: Interior use</td>
<td>$250/$450.00</td>
</tr>
<tr>
<td>Black and white reproductions: Interior use</td>
<td>$100/$200.00</td>
</tr>
</tbody>
</table>

Note: Language rights may also be obtained on individual permission to publish basis

**Delivery**

Via internet download service or ftp site

**RUSH SERVICE**: non-profit/commercial

$75/$150.00

Delivery within 2 weeks is available for most orders, except new photography; please verify in advance.

Please note there is a 4-6 week processing time with regular (non-rush) service.

Fees are payable by check in US dollars, drawn on a US bank. Credit cards are accepted for rush orders.
Permission fees are applicable for one-time reproduction rights in one language, one edition only unless otherwise negotiated. Further language rights, revised editions, and additional media, will incur separate permission to publish fees.

**HOW TO REQUEST AN IMAGE**
Submit your request by email to reproductions@brooklynmuseum.org, with your billing address, details of work(s) of art (accession number and jpeg if available), intended use of the image and/or publishing details, color or b/w image required, and absolute deadline to Rights and Reproductions: 200 Eastern Parkway, Brooklyn, NY 11238-6052 (718) 501-6202; fax (718) 501-6145; e-mail: reproductions@brooklynmuseum.org
Appendix K: Sample Application for Permission to Reproduce Works from the Brooklyn Museum

<table>
<thead>
<tr>
<th>Brooklyn Museum</th>
<th>Application for Permission to Reproduce Works from the Brooklyn Museum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rights and Reproductions</td>
<td>Date: September 13, 2010</td>
</tr>
<tr>
<td>200 Eastern Parkway</td>
<td>Order number:</td>
</tr>
<tr>
<td>Brooklyn, NY 11238</td>
<td>Permission to reproduce, if granted, is conditioned upon unequivocal</td>
</tr>
<tr>
<td>Tel: (718) 501-6202 Fax: (718) 501-6145</td>
<td>acceptance of the full regulations published by the Museum. Any breach</td>
</tr>
<tr>
<td><a href="mailto:reproductions@brooklynmuseum.org">reproductions@brooklynmuseum.org</a></td>
<td>of these terms and conditions will automatically result, at the sole</td>
</tr>
<tr>
<td>Addresssee</td>
<td>discretion of the Museum, in revocation of permission to reproduce.</td>
</tr>
<tr>
<td>Mailing</td>
<td>Permission to reproduce, if granted, is conditioned upon unequivocal</td>
</tr>
<tr>
<td>Addresss</td>
<td>acceptance of the full regulations published by the Museum. Any breach</td>
</tr>
<tr>
<td>Permission is hereby requested to reproduce the</td>
<td>of these terms and conditions will automatically result, at the sole</td>
</tr>
<tr>
<td>following work(s) from the collections of the</td>
<td>discretion of the Museum, in revocation of permission to reproduce.</td>
</tr>
<tr>
<td>Brooklyn Museum.</td>
<td>Permission to reproduce, if granted, is conditioned upon unequivocal</td>
</tr>
<tr>
<td></td>
<td>acceptance of the full regulations published by the Museum. Any breach</td>
</tr>
<tr>
<td>Artist, Date</td>
<td>of these terms and conditions will automatically result, at the sole</td>
</tr>
<tr>
<td>Title</td>
<td>discretion of the Museum, in revocation of permission to reproduce.</td>
</tr>
<tr>
<td>Medium, Dimensions</td>
<td>Permission to reproduce, if granted, is conditioned upon unequivocal</td>
</tr>
<tr>
<td>Brooklyn Museum. Acquisition</td>
<td>acceptance of the full regulations published by the Museum. Any breach</td>
</tr>
<tr>
<td></td>
<td>of these terms and conditions will automatically result, at the sole</td>
</tr>
<tr>
<td></td>
<td>discretion of the Museum, in revocation of permission to reproduce.</td>
</tr>
<tr>
<td>Project:</td>
<td>Permission to reproduce, if granted, is conditioned upon unequivocal</td>
</tr>
<tr>
<td>Name of publisher:</td>
<td>acceptance of the full regulations published by the Museum. Any breach</td>
</tr>
<tr>
<td>Print Run:</td>
<td>of these terms and conditions will automatically result, at the sole</td>
</tr>
<tr>
<td>Language editions:</td>
<td>discretion of the Museum, in revocation of permission to reproduce.</td>
</tr>
<tr>
<td>Type of publication:</td>
<td>Permission to reproduce, if granted, is conditioned upon unequivocal</td>
</tr>
<tr>
<td>Titled of book:</td>
<td>acceptance of the full regulations published by the Museum. Any breach</td>
</tr>
<tr>
<td>Author:</td>
<td>of these terms and conditions will automatically result, at the sole</td>
</tr>
<tr>
<td></td>
<td>discretion of the Museum, in revocation of permission to reproduce.</td>
</tr>
<tr>
<td>MATERIAL:</td>
<td>Permission to reproduce, if granted, is conditioned upon unequivocal</td>
</tr>
<tr>
<td></td>
<td>acceptance of the full regulations published by the Museum. Any breach</td>
</tr>
<tr>
<td></td>
<td>of these terms and conditions will automatically result, at the sole</td>
</tr>
<tr>
<td></td>
<td>discretion of the Museum, in revocation of permission to reproduce.</td>
</tr>
</tbody>
</table>

We have read and understand the accompanying regulations which govern the reproduction of works of art in our collections, and we agree to abide by each and every term and condition detailed therein.

Signed...................................................................................….

Date....................................................................................…....

(Please fill in blanks if not stated correctly at left)

Title (and author) of publication........................................

Publication date and print run............................................

Format (i.e., print, video, digital)......................................

Multiple editions....................................................................

Publishers.............................................................................

Permission is for one-time reproduction rights, one language, one edition only unless otherwise noted. Reproductions rights are granted for the purpose(s) specifically indicated, premised and conditioned upon payment of the fees involved.
Signed.......................................... Date .......................  
Ruth Janson, Coordinator of Rights and Reproductions  

Receipt of this executed application along with pre-payment of relevant fees, constitutes official permission for reproduction. Please sign and return the **two top copies** to the above address. 

- Two copies due upon publication  
- Color proofs/layouts required for covers
Appendix L: Brooklyn Museum Rights and Reproductions Agreement

REPRODUCTION FROM THE COLLECTIONS OF THE BROOKLYN MUSEUM

Permission to reproduce is conditioned upon unequivocal acceptance of these regulations. Any breach of these terms and conditions will automatically result, at the sole discretion of the Museum, in revocation of permission to reproduce. Payment of appropriate compensation or damages to the Museum by the applicant may also be considered.

1. Permission to reproduce and the fee payable cover only the specific party, occasion and use detailed in the application. Additional digital media (e-books, web-site, dvds), further editions (i.e. new ISBN numbers), different publisher imprints, ancillary projects and cover use must be approved by the Museum in advance and are subject to re-use fees. Reproduction rights are not transferable to a third party unless otherwise stated in writing by the Museum.

2. Object information and credit lines as stated in the body of our permission contract must appear with the reproduction unless otherwise specified.

3. Digital reproductions must be low resolution. When permission is granted for web sites, the image can be no larger than 800 pixels on the longest side.

4. Use in video, film, and digital media or new technologies must be negotiated separately and specific conditions apply. Unless otherwise noted, video/broadcast, rights are valid for a period of 10 years. Permission shall not be granted in perpetuity, or for all media now known or hereafter devised, unless otherwise agreed.

5. Reproduction (“lifting” or scanning) from printed, analog, digital formats or any photographic materials not directly supplied to the client by the Museum is strictly forbidden. Derivative images may not be made or distributed by outside companies or photographers for commercial sale.

6. The paint area of a picture, or the area within the outline of a sculpture, may not be masked out, cut down (“detail”), superimposed with type, bled, or in any way defaced or altered without submission of a layout and explicit permission from the Museum. When permissible, the work of art must be reproduced in its entirety elsewhere in the publication.

7. All final reproductions, unless specifically approved by the Museum prior to the reproduction, must be smaller than the original work(s) of art, except sculpture.

8. Color proofs and layouts must be submitted and approved prior to publication for cover reproductions, commercial products and other non-art historical usage.

9. Any unauthorized use of images provided by the Museum, by any person or entity, for any reason, whether or not authorized by the applicant, will render the applicant responsible and liable to the Museum for appropriate compensation.

10. The Museum reserves the right, at its sole discretion, to refuse permission for further applications from a publisher or other applicant, if, in its opinion, the standard of reproduction has not been of acceptable quality.
11. The Museum will not grant an exclusive right to reproduce any work(s) of art in the Museum; nor will the Museum assume any responsibility for reproduction of the same work(s) of art by any other party. The Museum assumes no responsibility for claims against the applicants or the Museum by third parties, (including the artists, their agents or estates). Applicants agree to indemnify the Museum and hold it harmless against any and all such claims and costs, including copyright infringement claims arising out of applicant’s reproduction of the work(s) of art in question.

12. To authorize reproduction of works created by living artists or works created since January 1, 1978, the Museum must receive a copy of the permission obtained by the applicant from the artist or representative.

13. Any clause added to the body of the permission contract, supersedes these conditions.
BROOKLYN MUSEUM
Rights and Reproductions
200 Eastern Parkway
Brooklyn, NY 11238-6052
TEL: 718-501-6202 FAX: 718-501-6145
reproductions@brooklynmuseum.org

INVOICE TERMS: Paid by Paypal(MDSRIREP 370 - )  INVOICE NUMBER:

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Description</th>
<th>Price</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Digital image, color, tiff 400 dpi</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Reproduction fee</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Rush service fee</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Object:
Artist, Date
Title
Medium, Dimensions
Brooklyn Museum. Acquisition

Project: Description
Name of publisher:
Print Run:
Language editions:
Type of publication:
Titled of book:
Author:

Date:
<table>
<thead>
<tr>
<th>Description</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>PayPal fee</td>
<td>$</td>
</tr>
<tr>
<td>Processing, Shipping &amp; Handling,</td>
<td>$</td>
</tr>
<tr>
<td>Federal ID#: 11-1672743</td>
<td>TOTAL</td>
</tr>
<tr>
<td>Payment should be made by check in <strong>U.S. dollars, drawn on a U.S.</strong> bank and sent to Brooklyn Museum, <strong>Rights and Reproductions</strong>. Bank transfers can be directed to the Chase Manhattan Bank, 4 Chase Metrotech Center, Brooklyn, NY 11245, Brooklyn Museum general operating account no. 616810016, Bank routing #: 021000021; Swift, BIC, code: CHASUS33, <strong>NET OF ALL CHARGES</strong>. Please reference our <strong>invoice number, department name, and your project name</strong> in payment remittance.</td>
<td>$</td>
</tr>
</tbody>
</table>
Host Organization Supervisor Report
Internship

To be filled out by the Host Organization Supervisor upon or near completion of required hours.
PLEASE TYPE OR PRINT NEATLY

Organization: Brooklyn Museum
Supervisor Name: Deborah Wythe
Phone: 718 501 6311
Email: Deborah.wythe@brooklynmuseum.org
Student Name: Alice Cork
Dates of Student work (from, date - to, date): September 2010 - December 2010

1. Briefly describe the major responsibilities assigned to the student and your expectations.

Alice worked on our copyright clearance project, researching contact information for artists in the collection whose works are protected by copyright, generating non-exclusive licenses and cover letters, and updating the Museum’s collections management system to reflect the licenses acquired.

In addition to her main project, Alice filled in for a volunteer on an extended sick leave, assisting our Rights & Reproductions Coordinator in fulfilling external license requests.

Since this was a full-time internship, I suggested that Alice spend one day a week exploring other museums in NYC. I think this was a very valuable addition to her experience.

Alice’s work met all expectations.
2. Has the student performed these responsibilities and tasks in a thorough and professional manner?
Alice's work has consistently been of a very high level. Work is completed in a timely fashion, multiple project strands are kept organized; she knows when to ask questions and is able to formulate a reasonable proposed answer when she encounters a problem.
She was very productive during her time here, sending out license requests for 831 works by more than 100 artists and receiving responses for 303 works. The cleared works have now been released at full size on our website. (for example: Leonard Baskin (73 works): http://bit.ly/e8tHyL)

3. Has the student worked well with your professional staff? Your volunteers?
She is well respected in the department and interacts in a low-key but friendly manner with both staff and volunteers. In particular, she has been very helpful in training another intern working on the same project. We are looking forward to continuing to work with her on a volunteer basis over the next months and hope to be able to bring her on our staff of an upcoming temporary project.

4. Has the student kept to the agreed work schedule?
Yes.

5. Have there been any problems?
No problems - an entirely satisfactory experience.

6. How could the Internship have been better structured to make it more beneficial to the organization? To the student?
For us:
This internship fulfilled all expectations.

For the student:
Unfortunately there were no relevant copyright symposia in NYC this fall - I would have liked to provide Alice with some experience outside our walls and our project and wish that she could have accompanied me to a professional meeting such as the MCN annual meeting in Austin, where I spoke about our (her!) project. Having some extra funding for professional development would be a major plus for our interns, but is only available when their internship is part of a grant-funded project.

7. Comments and suggestions.
Thank you for sending us Alice. I think that your semester-long full time internship is a very valuable program. Our other interns usually spend only about 120 hours with us over a semester (1 day a week) and I find that just as they are getting up to speed, they're ready to leave.
Vita

Alice Cork was born in Canberra, Australia. She graduated *summa cum laude* from the honors program at Loyola University New Orleans with a Bachelor’s degree in Psychology in 2006. She entered the Arts Administration program at the University of New Orleans in 2008. That year she was awarded a SG travel grant to attend the Association of Performing Arts Presenters in New York City. In 2009 she was awarded an international education scholarship to travel to Rome, Italy for an intensive course in Roman Art History. Upon graduation, she will be accepting a position with the Brooklyn Museum.